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Cumulus Browser
Cumulus Browser (or Cumulus) allows digital and media professionals to organize, track, preview, copy, move, 
annotate and archive virtually any type of digital media, including graphic, page layout, presentation, sound, and 
video files, turning them into media assets. By being able to effectively track, locate and retrieve these assets, you 
can improve quality and workflow, saving yourself and your organization valuable time and money.
See the glossary for any terms you don’t understand.
The following topics provide an overview of Cumulus:

· How Cumulus Works 

· Using Online Help 

· Using Window Menu Commands 

· Technical Support 

· Roadmap to Common Tasks 



 Cumulus Desktop
How Cumulus Works

Within the graphics, publishing, and multimedia industries, media assets (assets) can be virtually any type of digital 
media file including image, graphic, page layout, sound, and video files. With Cumulus, organizing and accessing 
media assets is easy. To get started, you need to understand only a few basic concepts. 
Cumulus tracks media assets in a special file called a catalog. As you catalog media assets, Cumulus creates 
catalog entries called records. To make searching and retrieving records easier, Cumulus lets you organize and 
classify records into logical groups called categories. 
Once records are cataloged, you can view each one as a graphical thumbnail or as plain text. You can search and 
retrieve records within Cumulus. Once you locate the record you’re looking for you can preview, copy, or move it to 
a new location.
In addition, Cumulus offers the following benefits:

· You can automate basic program functionality through Microsoft¨ Visual Basic¨ or any other OLE-compliant 
programming tool. 

· With the Cumulus Browserª you can distribute catalogs on CD-ROM or any other type of removable media (such
as Syquest, Jaz, Zip, or MO cartridges). 

· You can publish and distribute catalogs over the internet using the Cumulus Internet Media Serverª.
{button ,AL(`intro',0,`',`')}    See also 



 Cumulus Browser
Using Online Help

Cumulus features an extensive online help system. To browse a listing of help topics, select Help Topics from the 
Help menu. A listing of help topics appears. 
You can find out your version number, serial number and product ID by choosing About Cumulus on the Help menu.
You can connect to the Canto website to receive information and software updates by choosing Connect to Canto on
the Help menu.
To activate context sensitive help:
1. Click the option you’d like information on.
2. Press F1.
{button ,AL(`intro',0,`',`')}    See also 



 Cumulus Browser
Using Window Menu Commands

You can use commands on the Window menu to arrange the open windows in Cumulus:
New 
Wind
ow

Opens a new window with the same contents
as the active window. You can open multiple 
windows. If you change the contents in one 
window, all other windows containing the 
same data reflect those changes. When you 
open a new window, it becomes the active 
window and is displayed on top of all other 
open windows. Use the Tile and Cascade 
commands on the Window menu to display 
multiple open windows.

Arra
nge

Arranges the icons for minimized windows at
the bottom of the main window.    If you see 
an open window at the bottom of the main 
window, some or all of the icons may not be 
visible because they will be underneath this 
window.

Casc
ade

Arranges multiple opened windows in an 
overlapped fashion.

Tile 
Horiz
ontal

Arranges multiple opened windows in a 
nonoverlapped fashion.

Split Splits the current window. You can scroll the 
split parts separately to see two parts of it at
once.



 Cumulus Browser
Technical Support

Canto Software offers free technical support to registered customers. To provide you with easily accessible, first-
class assistance, Canto has partnerships with numerous distributors and resellers around the world. Because of this,
the number you call depends upon where you purchased Cumulus. 
For a complete listing of technical support numbers, please see Support & Solutions on the Canto Software website: 

http://www.canto-software.com
Before contacting technical support, please review Troubleshooting and Documenting Problems. To ensure fast and 
efficient service when calling, please have your serial number ready.
If your distributor/reseller does not provide support for Cumulus, please address technical questions to: 

North America and South America
Canto Technical Support
Main: 415-905-0300
Technical Support: 415-905-0302
Fax: 415-905-0315
e-mail: support@canto-software.com 

Europe, Australia, Africa and Asia
Canto Technical Support
Main: +49-30 390 48 50
Fax: +49-30-393 10 93
e-mail: support@canto.de

{button ,AL(`intro',0,`',`')}    See also 



 Cumulus Network 4 Client
Roadmap to Common Tasks

If you want to... See...
assign status terms to 
records

Utilizing Record Status 

catalog assets Cataloging 
contact technical support Technical Support and Documenting 

Problems 
customize cataloging 
options

Setting Cataloging Options 

customize Cumulus 
application preferences

Customizing Application Preferences 

display record properties Customizing Record Properties 
learn about basic program 
functionality

The Basics 

learn about Cumulus 
Browser

Using the Cumulus Browser 

learn about Internet Media 
Server

Cumulus Internet Media Server 

locate, copy, move, delete 
or edit assets

Managing Assets 

preview cataloged assets Previewing Cataloged Assets 
print information Printing Information 
review how other customers
have integrated Cumulus 
into their work 
environments

Using Sample Scenarios 

search for information Searching 
update or check file 
references

Checking File References 

update records Updating Records 
{button ,AL(`intro',0,`',`')}    See also 



Cumulus Basics
Launching Cumulus and Opening a Catalog 
Closing a Catalog 
Exiting Cumulus 
The Cumulus Application Window 
Using the Toolbar 
Understanding the Catalog Window 
Using the Status Bar 
Using the Record Pane 
Using the Category Pane 
Using Edit Menu Commands 
Printing Information 



 Cumulus Basics 
Launching Cumulus and Opening a Catalog

You can open a catalog when you start the Cumulus application.
To launch Cumulus Client and open a catalog:
1. Click the Start button, point to Programs, select Cumulus and then Cumulus Browser, Cumulus Desktop, or 

Cumulus Desktop PLUS.
Cumulus loads and any previously loaded catalog is displayed.

2. If this is your first time running Cumulus, the Open Catalog dialog box appears.
If you did not have a catalog open the last time you exited Cumulus, or if the Open dialog does not appear, 
select Open from the File dialog to see the Open dialog box.

3. Select a catalog from the list and click OK.
Note: To open another catalog during a Cumulus session, choose Open on the File menu and select the catalog 
name. To close an open catalog, choose Close from the File menu.
If your workplace also has Cumulus Network, and you are set up as a Cumulus Network client, you can log onto the 
server and open network catalogs, as well as the local catalogs on your own machine. To do this, use the Connect to
Server command on the File menu.
{button ,AL(`basics',0,`',`')}    See also 



 Cumulus Basics 
Closing a Catalog

To close an open catalog, choose Close from the File menu.



 Cumulus Basics 
Exiting Cumulus

To exit Cumulus, choose Exit from the File menu.



 Cumulus Basics 
The Cumulus Application Window

The Cumulus application window contains every command, option and window needed to catalog and categorize 
assets. Certain window options (including most toolbar buttons, the findbar , and the status bar) become active only
when a catalog file is loaded. 
Key user interface elements of the Cumulus application window are described below. You can control which 
elements appear by checking and unchecking them in the View menu.

Element Description
Menubar Lists menus that contain every Cumulus command. 

Underlined characters are keyboard shortcuts. To use a 
keyboard shortcut, display the menu, then type the 
underlined letter.

Toolbar Contains buttons that serve as shortcuts to commonly used 
commands and options. To see a Tooltip for any button, 
position the mouse over it.    For more information, see Using 
the Toolbar.

Findbar Allows you to search catalogs for records that match 
conditions. For more information, see Using the Findbar.

Category
Pane

Consists of coherently organized groups of records that 
facilitate fast searching and retrieval. For more information, 
see Using the Category Pane.

Catalog 
Window

Features two panes: the Category pane (left side) and the 
Record pane (right side). For more information, see 
Understanding the Catalog Window.

Record 
Pane

Displays records as thumbnails or as plain text. Records store
vital information about each cataloged asset. For more 
information, see Using the Record Pane. 

Status 
Bar

Provides toolbar button descriptions, access to the 
Application Preferences dialog box, category status, and 
record status. For more information, see Using the Status 
Bar. 

{button ,AL(`basics',0,`',`')}    See also 



 Cumulus Basics 
Using the Toolbar

Toolbar buttons offer quick and easy access to common commands and options. Positioning the cursor over a 
toolbar button displays a Tooltip.
You can move the toolbar to the top, bottom, left, or right side of the Cumulus application window, or make it a 
separate floating window. To move it, select its outer edge and drag it to the desired location. To temporarily turn off
the toolbar, uncheck Toolbar on the View menu.

Toolbar Button Description
Connects to Cumulus Server.

Cuts selection and copies it to the 
Clipboard.
Copies selection to the Clipboard.

Inserts selection from the Clipboard.

Shows or hides the Category pane. 

Displays assets using large thumbnails. 

Displays assets using medium thumbnails.

Displays assets using small thumbnails.

Displays detailed information (record 
name, format, color mode, resolution, and 
modification date) about each asset.
Sorts catalog by record name.

Sorts catalog by asset type.

Sorts catalog by asset color mode.

Sorts catalog by asset resolution. 

Sorts catalog by asset modification date.

Sorts catalog in ascending order (from A to 
Z) .
Sorts catalog in descending order (from Z 
to A) .
Displays the Record Properties dialog box. 

Displays a preview of the cataloged asset.

Displays help system topics.

{button ,AL(`basics',0,`',`')}    See also 
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Understanding the Catalog Window

Cumulus tracks assets in a special file called a catalog. When you open a catalog, a Catalog window appears.
The Catalog window consists of two sections or panes:
• the Category pane 
• the Record pane 
Cumulus offers four different Record pane viewing options. For more information, see Setting Record Viewing 
Options .
As you catalog assets, Cumulus creates catalog entries called records. Each record stores searchable information 
about the cataloged asset, such as the file name, the file location, file type, and so on. To make retrieving records 
easier, you can group records into logical groups called categories. The left side of the Catalog window is called the 
Category pane and displays all the categories in the current catalog. 
Press SHIFT+TAB to switch between the two panes. By selecting the split bar in the middle of the Catalog window, 
you can resize each pane. To resize the entire window, select the window borders or use the minimize, maximize, 
and restore buttons in the title bar.
{button ,AL(`basics',0,`',`')}    See also 



Catalog window



 Cumulus Basics 
Using the Status Bar

The status bar appears at the bottom of the Cumulus application window.

The far left side of the status bar displays toolbar button descriptions. To view these descriptions, position the 
cursor over a toolbar button.
The Search Compass appears next. Click this icon to display the Application Preferences dialog box. 
The Category Status field displays the number of current categories appearing in the Category pane as well as the 
total number of categories in the current catalog. For example, “19 of 105 categories (1 selected)” means that:
• 19 categories currently appear in the Catalog pane
• 105 total categories are available in the current catalog
• 1 category is currently selected
The Record Status field displays the number of found and total records in the current catalog. After a search, this 
field tells you how many records match the requested query. For example, “25 of 1173 (1 selected)” means that:
• 25 records match the current search conditions
• 1173 total records are available in the current catalog
• 1 record is currently selected.
{button ,AL(`basics',0,`',`')}    See also 



 Cumulus Basics 
Using the Record Pane

The Record pane appears on the right side of the Catalog window and displays records in the current catalog. By 
default, records appear within the Record pane as graphical thumbnails. You can alter the way records appear with 
options in the View menu. 
Each record stores information about the original asset. By default, a record name appears directly beneath the 
thumbnail. The record name can consist of up to 63 characters. For more information on assigning record names, 
see Editing Record Names.
To learn more about a record, position the cursor over the thumbnail. A Details window appears. You can optimize 
the appearance of thumbnails.
In a textual view, the Record pane lists the record name, format, the color mode, resolution, and modification date. 
You can resize the width of each column by adjusting the split bars between the column headers.
Cumulus displays` record information in a special window called the Record Properties dialog box. To view record 
properties, select a record and then click Properties on the Record menu. The Record Properties dialog box appears. 
You can display the Record popup menu by moving the cursor over a record thumbnail or text entry and single-
clicking the right mouse button. 
Within a given catalog you can:
• sort by record detail 
• sort by ascending or descending order 
{button ,AL(`basics',0,`',`')}    See also 



 Cumulus Basics 
 Using the Record Pane

Optimizing Thumbnails
If a thumbnail appears too dark, too bright, or too low in contrast, you can correct its appearance by selecting 
Optimize Thumbnail on the Record menu. You can automatically optimize thumbnails while cataloging. You can also 
alter the thumbnail size with toolbar buttons. 



 Cumulus Basics 
 Using the Record Pane

Record Viewing Options
To... Do this... 
display records as 192 x 192
pixel thumbnails

on the View menu, click Large 
Thumbnails

display records as 128 x 128
pixel thumbnails

on the View menu, click Medium 
Thumbnails

display records as 96 x 96 
pixel thumbnails

on the View menu, click Small 
Thumbnails

view records as detailed text on the View menu, click Details
{button ,AL(`basics',0,`',`')}    See also 



 Cumulus Basics 
 Using the Record Pane

Record Sorting Options
Records contain a great deal of information (or details) about an asset. By selecting View menu options, you can 
sort by:
• record name
• record type
• resolution
• color mode
• modification date
To sort by record detail:
1. On the View menu, click Sort By.
2. On the Sort By submenu, select a record detail (i.e., record name, type, resolution, color mode, or modification 

date).
The new sort order appears.

You can also sort records with toolbar buttons. Once you have sorted by detail, you can sort by order.
{button ,AL(`basics',0,`',`')}    See also 



 Cumulus Basics 
 Using the Record Pane

Sorting Records by Order
Once you have sorted by detail, you can sort by order. Sorting by order displays records in either ascending or 
descending order. 
To sort by order:
1. On the View menu, select Sort Order.
2. From the submenu, select Sort Ascending or Sort Descending.

The new sort order appears.
{button ,AL(`basics',0,`',`')}    See also 



 Cumulus Basics 
Using the Category Pane

The left side of the Catalog window is called the Category pane. The Category pane displays all categories in the 
current catalog. Categories serve as virtual folders that allow you to organize records into a logical, intuitive, and 
easy-to-use structure. Many Cumulus users create catalogs containing thousands of categories, each of which has 
numerous levels.
When you catalog an asset, Cumulus creates a record that stores information about the original digital media file. To
organize records, you can place them into categories. For information on creating categories, see Creating 
Categories .
Categories are like keywords. Unlike media management systems that rely solely on keywords to organize assets, 
categories offer the following advantages:
• Like keywords, you can assign categories unique names that describe assets.
• Through dragging and dropping, you can associate records (representing assets) to one or multiple categories.
• Categories are fully searchable, making the retrieval of assets easy.
• Unlike keywords, categories can create hierarchies. You can tailor each Cumulus catalog to be as simple or 

complex as the information you’re managing.
To display records in a selected category, double-click the category or select the category and press ENTER. 
You can expand or collapse categories by clicking the plus (+) and minus (-) buttons to the left of each category 
folder. To expand a category, click the plus (+) button to the left of the category name. As the Category expands, 
the plus (+) button becomes a minus (-) button. 
Moving the cursor over a category and clicking the right mouse button displays the Category popup menu, which 
features shortcuts to commonly used Category menu options. 
{button ,AL(`basics',0,`',`')}    See also 



 Cumulus Basics 
Using Edit Menu Commands

You can use the commands in the Edit menu to select, deselect, cut, copy, paste, delete, and undo certain operations.
Cut You can cut text in category names, record names, search 

values.
Copy You can copy text in category names, record names, search 

values.
Paste You can paste text in category names, record names, search 

values.
Delete You can delete categories and records.
Undo You can undo operations in name fields and search value fields,

but you cannot undo other operations.
Select All You can use Select All for categories and records.
Deselect 
All

You can use Deselect All for categories and records.



 Cumulus Basics 
Printing Information

Cumulus features context-sensitive printing capability. Use the Print Setup command to set printing options, such as
paper size. Although all printing commands are found on the File menu, the actual Print command that appears at 
any given time depends upon what is selected (i.e., records, categories, or asset previews). For information on 
printing asset previews, see Printing Previewed Images and Printing Assets from Other Programs.
You can:
· Print record information 
· Print category information 
· Print catalog activity information (administrator only) 
· Preview information before printing 
{button ,AL(`basics',0,`',`')}    See also 



 Cumulus Basics 
 Printing Information

Printing Record Information
You can print graphical thumbnails, record details, and the contents of the Record Properties dialog box.
To print record information:

1. Select the records to print.
To select a sequence of records, hold down SHIFT and highlight the first and last record in the sequence.

2. On the File menu, click Print Records.
3. From the submenu, select one of the following:

• As Small Thumbnails prints selected records as small thumbnails

• As Medium Thumbnails prints selected records as medium thumbnails

• As Large Thumbnails prints selected records as large thumbnails

• Details prints the record’s name, format, color mode, resolution, and modification date in a convenient 
table format

• Properties prints the contents of the Record Properties dialog box
4. Make the appropriate selections in the Print dialog box and click OK.
{button ,AL(`basics',0,`',`')}    See also 



 Cumulus Basics 
 Printing Information

Printing Category Information
You can print information about the selected categories. You can also print previews of cataloged assets from within 
Cumulus or print an asset using another program. For more information see Printing Previewed Images and Printing 
Assets from Other Programs.
To print category information:

1. Select the categories to print.
To select a sequence of categories, hold down SHIFT and highlight the first and last category in the sequence.

2. On the File menu, click Print Categories.
3. Make the appropriate selections in the Print dialog box and click OK.
{button ,AL(`basics',0,`',`')}    See also 



 Cumulus Basics 
 Printing Information

Printing Catalog Activity Information (administrator)
You can print information about the current catalog. You can also print previews of catalog activity information. For 
more information see Printing Previewed Images.
To print catalog activity information:

1. Display the Administration view.
On the File menu, click Print Catalog Activity.
Make the appropriate selections in the Print dialog box and click OK.
{button ,AL(`basics',0,`',`')}    See also 



 Cumulus Basics 
 Printing Information

Previewing
Print Preview allows you to view a print selection prior to printing. 
To preview record information prior to printing:
1. On the File menu, click Print Preview Records or Print Preview Categories.
2. From the submenu, select one of the following:

• As Small Thumbnails displays a preview of records as small thumbnails 

• As Medium Thumbnails displays a preview of records as medium thumbnails

• As Large Thumbnails displays a preview of records as large thumbnails

• Details displays a preview of record details in a convenient table format (i.e., the record name, format, 
color mode, resolution, and modification date)

• Properties displays a preview of the Record Properties dialog box 
A Preview window appears.

3. Select the appropriate button at the top of the window:

• Print prints the current view

• Next Page scrolls to the next page

• Prev Page returns to the previous page

• Two Page redraws the current view in a two-page format

• Zoom In/Zoom Out controls the magnification of the current view

• Close exits from Preview mode.
{button ,AL(`basics',0,`',`')}    See also 



Cataloging
Cataloging Overview 
Cataloging Rules 
Cataloging Techniques 
Creating Categories and Subcategories 
Cataloging Using Drag-and_Drop 
Cataloging Using the Catalog Assets Command 
Editing Categories 
Updating Static Record Information 



 Cataloging 
Cataloging Overview

Cataloging is the process by which you integrate an asset into a catalog by creating records and optionally 
assigning them to categories.
Adding an asset to a catalog creates a catalog entry (or record) that stores information about the original digital 
media file (e.g., the file name, the file location, file type, resolution, etc.). Categories allow you to organize records 
into logical, easy-to-use hierarchical groups. 
When you catalog assets stored on the server running Cumulus Server, Cumulus automatically matches file names 
and paths with the appropriate operating system (Macintosh or Windows). If you store your assets in a location 
other than your own machine, be sure to follow normal cross-platform file naming rules. 
Before cataloging, review the Cataloging Rules and be aware that Cataloging options directly impact the way in 
which the cataloging works. 
There are two ways to catalog records:

Drag and drop media files from Windows Explorer or Desktop to the Catalog window 
Use the Catalog Assets command 

Once you’ve decided upon the cataloging method that best fits your needs, you can automate the process through 
Visual Basic or any other OLE compliant programming tool. 
{button ,AL(`catalog',0,`',`')}    See also 
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Cataloging Rules

The following rules make implementing Cumulus easier. 
• Create a Cumulus implementation plan.

Determine how to implement Cumulus. 
• Create a logical asset naming system.

Implementing an effective asset naming convention will save you time. An asset’s file name should tell you 
what the asset is. If your needs are complex, create a “cheat sheet.” 

• Organize assets into logical folders.
When grouping assets into directories, consider future projects and archiving requirements. You can group 
assets by project, or group them by type (e.g., video, audio, graphics, and layout files) and then separate them 
by format. For example, within a folder called Video, you could create sub-folders called QuickTime, AVI, or 
MPEG. 
By organizing your assets before you catalog them, you can take advantage of Cumulus’ ability to 
simultaneously create categories and records in one easy step. For more information, see About Automatically 
Created Categories.

• Create a logical record naming system.
When you catalog a file, Cumulus automatically assigns the media file name as the record name. However, you
can change the record name in the Record Properties dialog box. 
If your organization assigns project numbers, you can include them in record names (e.g., Project 12345 ABC 
Corporation). You can also include information you might want to search for later (e.g., job numbers or archive 
locations).
Avoid haphazardly assigning record names. If you do, you’ll end up with a catalog that contains contain cryptic 
record names that only the cataloger understands.

• Create a systematic cataloging process.
A systematic cataloging process ensures that asset naming, directory organization and record naming stay 
consistent from one cataloging session to the next. 

{button ,AL(`catalog',0,`',`')}    See also 



 Cataloging 
 Cataloging Rules

About Automatically Created Categories
When you catalog an asset, Cumulus automatically creates new categories that map the path (or location) to the 
media file. These categories display a small folder symbol within the category folder icon.
If you have a previously organized asset tracking system that utilizes nested folders broken out by project or file 
type, this feature allows you to catalog assets in one easy step.
Since this feature maps the path to the original media file, it also offers a quick and easy way to find assets. For 
more information enabling or disabling this option, see Include Folder Names as Categories.
{button ,AL(`catalog',0,`',`')}    See also 
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Cataloging Techniques

Most Cumulus users choose from one of two general cataloging techniques:
• Organize assets first

With this method, you first organize assets into a logical folder structure and then determine where the files will
be stored. You can drag and drop folders from Windows Explorer to the Catalog window, which automatically 
creates new categories that map the path to the original media file. 

• Create categories, then catalog
If your work environment doesn’t allow for the first method, you can use categories to organize your records. 
Create an effective, well-thought-out category structure, then catalog assets and associate records into the 
appropriate categories.

When you catalog your assets, you can use one of two methods:
Drag-and-drop from Windows Explorer 
The Catalog Assets Command 

{button ,AL(`catalog',0,`',`')}    See also 
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Creating Categories and Subcategories

Cataloging involves the creation of both categories and records. Categories are the organizational “backbone” of 
your catalog. They provide an efficient organizational and classification system and a powerful record search and 
retrieval system
Before you create categories, decide how you want to organize and group your records. For example, if you have a 
catalog called Animals, you can set up categories that describe common animal groups (e.g., birds, cats, dogs, 
rodents, etc.)
To create a new category:
1. On the Category menu (or from the Category popup menu), click New Root Category.

A new highlighted category named Category appears.
2. Type a new category name and press ENTER. Category names can be up to 255 characters in length.

Cumulus assigns the new category name.
3. Repeat steps 1 and 2 until you create all the categories you need.
Since many catalogs contain thousands of records, you may want to create hierarchical levels (or subcategories). 
To create subcategories:
1. On the Category menu (or from the Category popup menu), click New Subcategory.

A new highlighted category (named Category) appears.
2. Type a new category name and press ENTER. Category names can be up to 255 characters in length.
3. Repeat steps 1 and 2 until you create all the subcategories you need.
4. To move a category, select and drag it to an appropriate “parent” category.

To select a sequence of categories, hold down SHIFT and highlight the first and last category in the sequence.
{button ,AL(`catalog',0,`',`')}    See also 
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Cataloging Using Drag-and-Drop

With Cumulus you can quickly catalog assets by “dragging and dropping” files (or entire folders) from Windows 
Explorer or your Desktop to the Catalog window. 
To catalog assets by dragging and dropping files:
1. Launch Cumulus and open a catalog.
2. Launch Windows Explorer.
3. Minimize and arrange the Cumulus application window and Windows Explorer so each window takes up a 

portion of the screen.
4. In Windows Explorer, locate the file(s) to catalog.
5. Highlight the files(s) and/or folder(s) to catalog.

Hold down CTRL to select more than one file/folder at a time. Hold down SHIFT to select a range of files/folders.
6. Drag and drop your selections onto the Record pane. If you’ve already created categories, drag and drop your 

selections to a specific category.
Once cataloging is complete, Cumulus displays:
• new records in the Record pane
• new categories that mirror the path (or location) to the original media file

Categories Cumulus creates automatically are identifiable by the small folder symbol appearing within the category 
folder icon. By default, Cumulus assigns the asset’s file name as the record name. For information on customizing 
record information (i.e., the record name) see Customizing Record Properties.
{button ,AL(`catalog',0,`',`')}    See also 
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Cataloging Using the Catalog Assets Command

Compared to dragging and dropping files, this method has two limitations:
You can catalog only one file or folder at a time.
You cannot manually associate assets with existing categories.

By default, cataloging assets automatically creates new categories that mirror the path to the original digital media 
file. 
You can configure Cumulus to automatically associate records with specific categories. 
To create new records using the Catalog Assets command:
1. Launch Cumulus and open a catalog.
2. On the File menu, click Catalog Assets.

The Catalog Assets dialog box appears.
3. In the Look in box, locate the file(s) to catalog.
4. Catalog assets one by one or catalog entire folders at once:

• To catalog files one at a time, highlight each file and click Open.
• To catalog the entire folder, display the folder name in the Look in field and click Catalog All.
As Cumulus creates a new record, the original file name appears in the Cataloging status window. Once 
cataloging is complete, Cumulus displays:
• new records in the Record pane
• new categories matching the path (or location) to the original media file
By default, Cumulus assigns the asset’s file name as the Record name. For information on customizing record 
information (i.e., the record name) see Customizing Record Properties.

{button ,AL(`catalog',0,`',`')}    See also 
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Editing Categories

Once you create categories for your catalog, you can:
Associate records with categories 
Edit category names 
Use the Catalog Popup Menu 
Delete categories 
Create category cross-references by creating related categories 
{button ,AL(`catalog',0,`',`')}    See also 
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 Editing Categories

Associating Records with Categories
You can associate records with different categories.
To associate a record with a different category:
1. Select the records to move.

Hold down CTRL to select more than one record at a time. Hold down SHIFT to select a range of records.
2. Drag and drop the selected records onto the new category.

Cumulus copies the records to the selected category.
{button ,AL(`catalog',0,`',`')}    See also 
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Editing Category Names
To edit a category name, highlight the existing name and type a new one. You can also edit category names using 
the options found on the Edit menu (i.e., Undo, Cut, Copy, Paste, Delete, and Select All) or the Category popup 
menu.
{button ,AL(`catalog',0,`',`')}    See also 



 Cataloging 
 Editing Categories

Using the Category Popup Menu
The Category popup menu offers shortcuts to the following options. 

Command Description
Show Original Category When a related category is selected, this 

option displays the original category.
Show Related Categories If the selected category has related 

categories, selecting this option displays 
them.

Find Matching Records Displays all records associated with the 
selected category. 

Save Matching Assets As Saves copies of all assets to a new specified
location.

Expand If applicable, expands the hierarchical 
structure of the selected category.

Collapse If applicable, collapses the hierarchical 
structure of the currently selected category.

New Root Category Creates a new root category.
Show Categories 
Containing

Allows you to quickly locate a category.

Expand All Expands the hierarchical structure of all 
categories.

Collapse All Collapses the hierarchical structure of all 
categories.

To display the Category popup menu. 
1. Select the category name.
2. Click the right mouse button. 
{button ,AL(`catalog',0,`',`')}    See also 
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Creating Related Categories
You can create virtual cross-references called related categories. Related categories display an arrow symbol within 
their folder icons.
Related categories allow you to form relationships between categories. For example, suppose you have two 
categories called Insects and Food. The category Food contains the subcategory Honey. The category Insects 
contains the subcategory Bees. By creating related categories, you can create a virtual cross-reference between 
Bees and Honey.

Food Insects

Honey Bees
Related Category - 

Bees
Related Category - Honey

By creating these cross-references, searching for the category Honey finds records in both Honey and Bees. You can 
configure Cumulus to search for related categories.
To create a related category:
1. In the Category pane, select the category for which you wish to make a related category.
2. On the Category menu or the Category popup menu, click New Related Category.

A related category appears.
3. Drag and drop the related category onto the category for which you wish to create a virtual cross-reference.
{button ,AL(`catalog',0,`',`')}    See also 
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Deleting Categories
You can delete a category when the category folder structure no longer has any meaning. To find out if a category is
still being used, double-click it. If you delete automatically created categories, you can still locate assets in one of 
three ways:
• display the Record Properties dialog box and select the Asset tab to find the location
• select the record and then click Explore Asset from the Record menu
• search for the folder name using the findbar 
To delete a category:
1. Select the category to delete by clicking the folder to the left of the category name.
2. On the Category menu or the Category popup menu, click Delete Category.

A dialog box appears confirming your request. 
3. Click OK or Cancel.
{button ,AL(`catalog',0,`',`')}    See also 
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Updating Static Record Information

If you have access to the original media file, you can alter static record information (e.g., thumbnail, resolution, and 
size) for existing records by updating them. Updating a record refreshes the thumbnail and updates any static 
information that appears in the Record Properties dialog box if the file has changed. 
To update static information for existing records:
1. In the Record pane, select the record(s) to update.
2. On the Record menu, click Update.
3. From the submenu, select Always.
{button ,AL(`catalog',0,`',`')}    See also 
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 Working with Records 
Customizing Record Properties 

Adding an asset to a catalog creates a catalog entry called a record. Records store searchable information about an 
asset, such as its file name, file location, file type, resolution, etc. Cumulus displays record information in the Record
Properties dialog box. The Record Properties dialog box contains three tabs (Record, Notes, and Asset) and displays 
a graphical thumbnail on the right side. 
You can have Cumulus automatically display the Record Properties dialog box after it catalogs an asset. 
To view or alter record properties:

1. Select a record.

2. On the Record menu or the Record popup menu, click Properties.
The Record Properties dialog box appears.

3. Move from one tab to another by clicking a tab title.
Record 
Notes 
Asset 

4. Make selections by selecting them and clicking Apply. You can edit the record name.

5. To view other records without closing the dialog box, click the browse buttons beneath the thumbnail.

6. To activate your selections and exit the dialog box, click OK.
From within the Record Properties dialog box, you can display a popup menu that allows you to copy a thumbnail 
from one record to another, or copy from an asset preview to a record.
To copy a thumbnail:
Select the record whose thumbnail you want to copy.
Display the Record Properties dialog box.
Right-click over a thumbnail.
From the popup menu, choose Copy Thumbnail.
Select the record into which you want to paste the thumbnail
Display the Record Properties dialog box.
Right-click over a thumbnail.
From the popup menu, choose Paste Thumbnail.
{button ,AL(`records',0,`',`')}    See also 
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Editing Record Names
When you catalog a file, Cumulus automatically assigns the asset’s file name as the Record Name. You can change 
the Record Name to more fully describe the asset or to track it with your own internal naming conventions. This is 
useful if the original file name is not meaningful, or if the file is read-only.
A Record Name can be up to 63 characters long. Some users create names based on information they might want 
to search or sort for in the future (e.g., a job number or archive location). Certain characters are not compatible in 
all operating systems.
To edit a record name:
1. Select the record to rename.
2. On the Record menu, click Properties.

The Record Properties dialog box appears.
3. Highlight the existing name and type a new one.

The Record Name can be up to 63 characters long.
4. Click Apply.
{button ,AL(`records',0,`',`')}    See also 
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Using the Record Tab
The Record tab stores general information about the asset. 

Option/Field Purpose
Protection, Do 
not change

Prevents accidental changes to an asset.

Protection, Do 
not delete

Prevents anyone from deleting the asset.

Name Displays a unique record name. By default, Cumulus 
assigns the asset’s file name as the record name, 
but you can change it. 

Cataloged Displays the cataloging and record creation date.
Modified Displays the date the selected record was last 

modified.
User By default, contains the name of the person who 

cataloged the file. To edit the entry, highlight it, type 
a new name, and click Apply.
You can set this entry automatically.

Status Each record can be assigned one status from the 
Status list. To assign a different status , select it from
the Status list and click Apply.

Categories The Categories list displays all categories the record 
is currently associated with. 
To remove the relationship between a record and a 
category, select the category, click Remove, and 
click Apply.

{button ,AL(`records',0,`',`')}    See also 
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Using the Notes Tab
The Notes tab allows you to enter additional searchable information about a record. Notes serve both as a place to 
store information about a record and as a search condition.
Each record can have up to 32 KB of note text including, for example:
• where the asset came from
• the location of related information (i.e., hard copies, transparencies, video clips, or audio recordings)
• copyright, usage rules, permission, or license information
• instructions on how to print, use, or edit the asset
• the asset’s “change history” (how, what, and when an asset was altered)
• IPTC header information from JPEG or JFIF files (specific formats specified by the International Press 

Telecommunications Council and used by newswire services).
When entering note information, remember that unusually large notes can slow down overall performance. In 
general, remember to:
• keep notes as brief as possible
• avoid using unneeded words (i.e., the, a, or an)
You can automate note creation. 
{button ,AL(`records',0,`',`')}    See also 
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Using the Asset Tab
The Asset tab stores mostly static information about the asset that is captured during the cataloging process. 

Option/Field Purpose
MacOS/
Windows

Displays the location of the cataloged asset using 
both Macintosh and Windows operating system 
conventions.

Program Lists the program that is associated with the 
cataloged asset.

File Format Displays the file format of the cataloged asset.
Size Displays the size of the cataloged asset.
Created Displays the date the asset was created.
Modified Displays the date the asset was last modified.
Color Mode Displays the asset’s color mode (i.e., line art, 

grayscale, or color).
Resolution Displays the asset’s resolution (dpi or dots per 

inch).
Height Displays the asset’s height.
Width Displays the asset’s width.
More 
Information

Displays specific information that was imported 
during the cataloging process and is specific to the 
file format (e.g., the duration of a video clip). 

{button ,AL(`records',0,`',`')}    See also 
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Removing Records from a Catalog

When you delete an asset, you can specify whether or not to delete its original media file as well. 
To remove an assigned record from a catalog:
1. In the Record pane, find and select the record to remove.
2. From the Record menu or the Record popup menu, click Delete Record, or press DELETE.

The Delete Records dialog box appears.
Selecting Also delete Asset deletes both the selected record and the original media file. Use the Also delete 
Asset option carefully. 

3. To delete the selected records, click Delete. To cancel, click Cancel.
{button ,AL(`records',0,`',`')}    See also 
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Updating Records

If you modify an asset after cataloging, it’s a good idea to update its record. Updating a record refreshes the 
thumbnail and updates any static information that appears in the Record Properties dialog box. Customizable record
information (e.g., Record Name and Notes) is not affected by updating. You must have access to the original asset 
files to update catalog records. It is best to have an automated update procedure.
To update a record:
1. In the Record pane, select the records to update.
2. On the Record menu or the Record popup menu, click Update.

3. From the submenu select either If Asset has Changed or Always.

• If Asset has Changed updates record information only if the current asset has changed since cataloging.

• Always creates a new thumbnail and updates record information regardless of when the asset was last 
changed. This is useful if you have altered an asset or updated the general Cataloging Options.

{button ,AL(`records',0,`',`')}    See also 
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Checking File References

If you move an asset after cataloging, check the reference Cumulus uses to locate the file. Keeping this file 
reference up-to-date is crucial. 
When you check a file reference, Cumulus verifies that the asset is still located in the same place it was when it was
cataloged. If Cumulus cannot find it, a dialog box appears so you can specify a new location. You must have access 
to the original media files to check file references. 
To check an asset’s file reference:
1. In the Record pane, select the records to check.
2. On the Record menu or the Record popup menu, click Update Asset Reference.

Cumulus checks (or resolves) all file references and updates the record. 
If the original file cannot be found, a dialog box appears. The name of the media file in question appears in the 
File name field.

3. To re-establish a link to a media file, locate and highlight the file in the Look in box and click Open.

4. To ignore a specific media file, click Skip File.
{button ,AL(`records',0,`',`')}    See also 
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Exporting and Importing Information

You can export record, category, or query information to a tab-delimited text file which can then be imported into 
other catalogs or applications. This lets you move large numbers of records between catalogs or merge record data 
with other applications. 
The file type Cumulus creates depends upon the information you are exporting. 

Export/Import 
Information

Cumulus File Type/Extension

Category information Cumulus Category Exchange File (*.cce)
Record information Cumulus Record Exchange File (*.cre)
Query information Cumulus Query Exchange File (*.cqe)

When exporting both category and record information, you must first export/import categories and then the records
that are assigned to them. Failure to export and import in this order breaks the relationship between categories and 
records.
{button ,AL(`records',0,`',`')}    See also 
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Exporting Information
You can export record, category, or query information to a tab-delimited text file which can then be imported into 
other catalogs or applications. 
To export record, category, and query information:
1. In the Catalog window, select the records, categories, or queries to export.
2. On the File menu, click Export and select the appropriate submenu option.

The Save As dialog box appears.
3. In the Save in field, specify where to save the Cumulus Record Exchange File.

4. To accept the default file name, click Save. Otherwise, enter a new name in the File name field and then click 
Save.
Cumulus saves the information in the appropriate location using the appropriate file type.

{button ,AL(`records',0,`',`')}    See also 



 Working with Records 
 Exporting and Importing Information

Importing Information
Cumulus creates three specific file types when exporting record, category, or query information. You can use the 
Import command to import this information, or you can copy records and categories by dragging and dropping them
between catalogs.
To import record, category, or query information into a catalog:
1. On the File menu, click Import.
2. From the submenu, select the appropriate import option.

An Open dialog box appears.
2. In the Look in box, select the file to import and click Open.
{button ,AL(`records',0,`',`')}    See also 
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Utilizing Record Status

Every record can be assigned a user-defined status, which provides information about its condition or state, for 
example, scanned, retouched, under revision, approved. Every catalog has one status list which can consist of 1 to 
256 terms. There are two ways to assign status terms:
• Automatically assign a default status term during the cataloging process. 
• Manually assign the status term in Record Properties dialog box.
You can add, change, and delete status terms.    
To add a new status term:
1. On the Record menu, click Status List.

The Status List dialog box appears. By default the Status List contains the default term Status.
2. Click Insert Above or Append to add a new status term:

• To add a new term above Status, click Insert Above. 

• To add a new term below Status, click Append.
A new window appears.

3. Type a new status term. To enter additional terms, click Insert Next or Append Next. When all new terms have 
been entered, click OK.

To change an existing status term:
1. On the Record menu, click Status List.

The Status List dialog box appears.
2. From the list of available status terms, select the one to change and click Change.

The Change Status window appears.
2. Edit the existing status term and click OK.
To delete status terms:
1. Open the catalog containing the status term to delete.
2. On the Record menu, click Status List.

The Status List dialog box appears. If you delete a term currently assigned to a record, a dialog box appears. 
Select a new status for the record and click OK.

3. From the list of available status terms, select the term to delete and click Delete. You cannot delete the last 
remaining term.

{button ,AL(`records',0,`',`')}    See also 
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Using the Record Popup Menu

The Record popup menu offers a shortcut to commonly used Record menu commands. 
Command Description
Cut Cuts the selection and copies it to the Clipboard.
Copy Copies the selection to the Clipboard.
Paste Pastes the contents of the Clipboard to a new location 

(e.g., a catalog).
Update Refreshes the thumbnail and updates any static 

information that appears in the Record Properties dialog 
box. 

Update Asset 
Reference 

Updates the reference to the asset location. If Cumulus 
cannot find the asset, a dialog box appears so you can 
specify a new location.

Delete Record Deletes the currently selected record. 
Rotate 
Thumbnail

Rotates the selected thumbnail 90 degrees clockwise, 90
degrees counterclockwise, or 180 degrees. 

Optimize 
Thumbnail 

Optimizes a thumbnail’s appearance.

Open Asset 
with

Launches the program associated with an asset so you 
can preview or edit it.

Print Asset 
with

Launches the program associated with an asset so you 
can print it.

Explore Asset Lets you manually locate assets in Windows Explorer. 
Copy Asset To Copies assets to the specified location. 
Move Asset To Moves an asset to a new location. This copies the asset 

and deletes the file in the original location.
Send Asset Routes an asset through e-mail by attaching it to an e-

mail message. 
Asset Preview Displays a preview of an asset. 
Properties Displays the Record Properties dialog box.

To display the Record popup menu:
1. Move the cursor over a record thumbnail or text entry and click the right mouse button.

The Record popup menu appears.
2. To select a specific menu option, click it.
{button ,AL(`records',0,`',`')}    See also 
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 Searching 
Searching Overview

In Cumulus, there are three ways to search for records:
• search for records that match a specific category 
• use the findbar to build search queries that consist of one or more search conditions. You can save queries you 

create. There are two types of searches:
• simple searches 
• compound searches 

• browse the Catalog window
You can switch between methods as needed. 
{button ,AL(`search',0,`',`')}    See also 



 Searching 
Using the Findbar

The Cumulus findbar lets you build search queries consisting of one or multiple search conditions. By default, the 
findbar appears at the top of the Cumulus application window, directly below the toolbar. You can drag the findbar 
to another location. You can hide or display the findbar by clicking Findbar on the View menu. You can change the 
focus to a condition or query field with commands on the Find menu.

The findbar consists of three basic components that allow you to build a search query:
• The condition buttons on the left side of the findbar determine the number of search conditions. If your query 

has more than one condition, the condition buttons are next to the current condition. 
Condition Button Function
Insert Condition Above Adds a new condition above the current 

one.
Insert Condition Below Adds a new condition below the current 

one.
Delete Condition Removes the current condition.
Delete All Conditions Removes all conditions.
Duplicate Condition Copies the current condition.

• The three search condition fields (in the middle of the findbar) let you build a search. 
Condition Field Function
Criteria Defines what you’re searching for (e.g., 

record name, file type, color mode, etc.).
Operator Defines how you want to search (e.g., 

contains, starts with, is, is not, etc.).
Value Allows you to further qualify your search 

by adding single or partial words, 
numbers, or dates.

• The four search buttons on the right side of the findbar execute the search.
Search Button Function

Find in Active Catalog

Searches for all records in the currently 
active catalog.

Find Again

Searches the displayed records to narrow 
down the search results.

Find in All Catalogs

Searches for records in all currently open 
catalogs.

Show All

Displays all records in the currently active 
catalog.

There are two types of searches:
• simple searches 
• compound searches 

For examples of queries, see Search Query Examples. You can save queries you create.
{button ,AL(`search',0,`',`')}    See also 
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Changing the Focus to a Condition Field
You can set the focus (move the cursor) to the current condition in the findbar by choosing Select Condition Field 
from the Find menu.
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Changing the Focus to the Query Field
You can set the focus (move the cursor) to the query field by choosing Select Query Field from the Find menu.
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 Using the Findbar 

Running a Simple Search
Simple searches have only one search condition. Use simple searches in combination with the Find Again button to 
narrow down your search results. For examples of queries, see Search Query Examples.
To build a simple search:
1. Select a criteria from the Search Criteria field (e.g., record name, file type, color mode, etc.).
2. Select a search operator from the Search Operator field (the way in which you wish to search).

3. In the Value field, enter single or partial words, numbers, or dates to further qualify your search.
Dragging a record onto the Value field is a quick way to enter relevant record information. To clear all search 
fields, click Delete. 

4. Click the appropriate Search button (Find in Active Catalog, Find Again, Find in All Catalogs or Show All).
Cumulus displays all matching records in the Record pane. The Record Status field (on the right side of the 
status bar) summarizes how many records match the requested query. For example, “25 of 117 (1 selected)” 
means that:
• 25 records match the current search conditions
• 117 total records are available in the current catalog
• 1 record is currently selected

{button ,AL(`search',0,`',`')}    See also 
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Running a Compound Search
Compound searches have two or more search conditions. For examples of queries, see Search Query Examples.
To build a compound search:
1. Determine the number of search conditions to search for. 

• To add a search above the current selected condition, click Insert Condition Above.

• To add a search below the selected condition, click Insert Condition Below.
• To delete a search condition, click any of its condition fields and click Delete Condition.

2. For the first search condition:
• Select a criteria from the Search Criteria field (e.g., record name, file type, etc.).
• Select a search operator from the Search Operator field.
• In the Value field, enter additional information appropriate to further qualify your search.

3. From the Condition Operator field, select “and” or “or.” 
• The “and” operator finds only records that match both search conditions. “And” searches are more 

restrictive.
• The “or” operator finds any records that match either search condition. “Or” searches are broader and 

typically result in a higher number of matching records.
4. For the next search condition:

• Select a criteria from the Search Criteria field (e.g., record name, file type, etc.).
• Select a search operator from the Search Operator field.
• In the Value field, enter single or partial words, numbers, or dates to further qualify your search.

Note: The box containing the Insert, Append, and Delete buttons appears next to 
the currently active search condition.

5. Repeat steps 3 and 4 until all search conditions have been entered.
6. Click the appropriate Search button (Find in Active Catalog, Find Again, Find in All Catalogs or Show All).

Cumulus displays all matching records in the Record pane. The Record Status field (right side of the status bar) 
summarizes how many records match the requested query. For example, “25 of 117 (1 selected)” means that:
• 25 records match the current search conditions
• 117 total records are available in the current catalog
• 1 record is currently selected

{button ,AL(`search',0,`',`')}    See also 



 Searching 
 Using the Findbar 

Search Query Examples
In a full-text search, Cumulus searches for full or partial words, numbers, or dates without regard to capitalization. 
The following examples show how to search for records using various record characteristics. For example, searching
for r_s would find “for single.”

To search 
for...

use one of these 
operators...

and this value...

Record 
Name

Enter single or partial words to 
perform a full text search.

File Format Select or enter a file format.

Color Mode From the list, select Line Art, 
Grayscale, or Color.

Resolution Enter a numeric value for 
resolution in dots per inch (dpi).

File Size Enter numbers in bytes: 
type KB for kilobytes 
type MB for megabytes 

Modificatio
n Date (of 
the record)

Enter a date using the format 
specified by your operating 
system.

Creation 
Date
(of the file)

Enter a date using the format 
specified by your operating 
system.

Volume 
Name

Enter single or partial words to 
perform a full text search.

File Name Enter full or partial words to 
perform a full text search.

Folder 
Name

Type the full or partial name of a 
folder as it appears in Windows 
Explorer (case-insensitive).

User Name Enter full or partial words to 
perform a full text search.

Status From the list, pick a status.



Thumbnail Drag and drop a sample thumbnail 
onto the field to perform a 
similarity search, comparing 
brightness and contrast with a 
loose tolerance.

Category Enter a Category name or drag a 
category or a record from the 
Catalog window. 
If your category structure includes 
duplicate category names, drag 
and drop a category rather than 
typing its name. 
The Application Preferences dialog 
box controls how Cumulus 
searches categories. 

Notes Enter full or partial words to 
perform a full text search.

{button ,AL(`search',0,`',`')}    See also 
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Saving Search Queries

You can save any search query. By default, the querybar is disabled. To display the querybar, select Querybar from 
the View menu. The querybar appears to the right of the toolbar.    

To save the active search query:
1. In the querybar, type a name and click Save Query.
2. Cumulus adds the new query to the querybar list.
To retrieve a saved search query:
1. On the findbar, select a search condition by clicking its Condition field.
2. On the querybar, select a saved query from the list.

Cumulus inserts the saved query.
To delete a saved search query:
1. On the querybar, select the query you wish to delete.
2. Click the Delete Query button.

Cumulus deletes the query from the querybar list.
{button ,AL(`search',0,`',`')}    See also 
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Understanding Category Search Preferences

You can select a number of search preferences in the Search tab of the Application Preferences dialog box. Under 
Category View Search Finds Records you can select one of two search techniques:
• Matching At Least One Selected Category finds records associated with at least one of the categories included 

in your search.
• Matching All Selected Categories finds records associated with all categories included in your search.
Under Category Search Also Finds Records of... you can determine the direction Cumulus searches categories (that 
is, Categories Above the Selected and/or Categories Below the Selected). 
The “and Related Categories” option allows you to search for related categories. 
{button ,AL(`search',0,`',`')}    See also 
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Using the Search Compass Icon

The Search Compass icon in the center of the status bar displays information about current search preferences and 
is a shortcut to the Application Preferences dialog box.
The icon tells you which search preferences are currently enabled. Click the icon to display the Application 
Preferences dialog box and alter the search preferences if necessary.

Enabled Search Preferences Icon
Matching At Least One Selected 
Category
Matching All Selected Categories
Category Search Also Finds 
Records of Categories Above the 
Selected
Category Search Also Finds 
Records of Categories Below the 
Selected
And Related Categories

{button ,AL(`search',0,`',`')}    See also 
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Browsing the Catalog Window

Browsing the Catalog window is a simple, common-sense approach to finding records. If you’ve taken the time to 
design a well-organized category structure, you can quickly locate records by expanding categories in the Catalog 
pane.
To view all records associated with a category, double-click it. To expand a category, click the plus (+) buttons to 
the left of the category name. When the Category expands, the plus (+) button becomes a minus (-) button.
{button ,AL(`search',0,`',`')}    See also 
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Viewing the Category List

You can view a list of all categories in the current catalog by choosing Category List from the View menu. When this 
item is checked, the category hierarchy appears next to the Record pane. Otherwise, only the Record pane appears.
{button ,AL(`search',0,`',`')}    See also 
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 Managing Assets 
Previewing Cataloged Assets

Once you’ve cataloged an asset, you can preview it without launching another application. You can set application 
preferences to launch an Asset Preview window any time you double-click a thumbnail. For more information, see 
Customizing Application Preferences. In preview mode, you can copy and print images. 
To display a preview of a cataloged asset:
1. In the Record pane, select the record representing the asset to preview.
2. On the Records menu, click Asset Preview.

For assets using proprietary formats, use the Open Asset With command. 
An Asset Preview window appears. You can zoom, scale, and rotate the preview.

3. To close an open Asset Preview window, click Close on the File menu, or click the Close button in the upper right
corner of the Asset Preview window.

{button ,AL(`manage',0,`',`')}    See also 
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 Previewing Assets 

Zooming, Scaling, and Rotating Previews
Displaying an Asset Preview window creates a new menu called the Preview menu and adds Preview buttons to the 
toolbar. You can change the Asset Preview window’s magnification and orientation or reset the view to the initial 
view. The current Zoom Factor appears on the right side of the status bar.
To zoom or rotate an Asset Preview window:
1. Select the Asset Preview window and make it the active window.

The Preview menu appears in the menubar and Preview buttons appear on the right side of the toolbar.

2. To zoom or rotate a preview, do one of the following:
• Select the appropriate Preview icon (i.e., Zoom Out, Zoom In, 90 degrees Counterclockwise or 90 degrees 

Clockwise).
• Select the appropriate Preview menu option (i.e., Zoom Out, Zoom In, 90 degrees Counterclockwise or 90 

degrees Clockwise). 
3. To reset the preview to its initial size, do one of the following:

• Select the Reset Preview icon.
• Select Reset to Initial Preview from the Preview menu. 

4. To fit the preview within the application window, do one of the following:
• Select the Fit Preview to Window icon.
• Select Fit to Main Window from the Preview menu. 

{button ,AL(`manage',0,`',`')}    See also 
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Copying Preview Images
If an Asset Preview window contains an image file, you can copy and paste it into a new document. For best quality 
and easier version control in a layout document, you may prefer to copy the actual media file. See Copying Assets 
and Placing Assets into New Documents.
To copy and paste a previewed image:
1. Select the Asset Preview window and make it the active window.
2. On the Edit menu, click Select All and then Copy.
3. Paste the copied image into your document.
To copy part of a previewed image:
1. Select the Asset Preview window and make it the active window.
2. Select the portion of the image to copy.

A small dotted line shows your selection.
3. On the Edit menu, click Copy.
4. Paste the copied image into your document.
{button ,AL(`manage',0,`',`')}    See also 
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Printing Previewed Images
You can print the previewed image from within Cumulus.
To print a previewed image from within Cumulus:
1. On the File menu, click Print Asset Preview.
2. From the submenu, select one of the following:

• from View
• with Application
The Print dialog box appears.

3. Make the appropriate dialog box selections and click OK. 
{button ,AL(`manage',0,`',`')}    See also 
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Locating Assets within Explorer

You can manually locate assets in Windows Explorer.
To locate assets in Windows Explorer:
1. Select one or more records in the Record pane, or display the Record Properties dialog box.
2. From the Record menu, click Explore Asset.
Cumulus launches Windows Explorer and locates the assets. If multiple assets are selected, multiple Explorer 
windows appear. 
{button ,AL(`manage',0,`',`')}    See also 
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Placing Assets into Documents

You can drag and drop a record from the Catalog window into a document in another application, if that application 
supports OLE dragging and dropping.
To place assets by dragging and dropping:
1. Make sure the target application is running and the destination document is open.
2. Launch Cumulus and locate the records representing the assets to place.
3. Click and drag the records to the target document.

Hold down CTRL to select more than one record at a time. Hold down SHIFT to select a range of records.
The asset appears in the target document.

{button ,AL(`manage',0,`',`')}    See also 
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Copying Assets 

Cumulus offers a number of different ways to quickly copy assets to a new locations. The records that Cumulus 
copies are controlled by category search preferences. From within Cumulus you can:
• Make copies of assets by dragging records or categories to the desktop.

When you drag categories to the desktop, Cumulus creates a folder matching the category name and copies all
the associated records into it.

• Copy assets to a new location using Copy Asset To on the Record menu. 
• Distribute assets to co-workers by attaching them to e-mail messages . 
{button ,AL(`manage',0,`',`')}    See also 
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Using Copy Asset To
You can copy one or more cataloged assets from either the Record pane or the Record Properties dialog box.
To copy assets:
1. Select one or more records in the Record pane.
2. From the Record menu, click Copy Asset To. You can also select Copy Asset To in the Record Properties dialog 

box by clicking the right mouse button and selecting it from the pop-up menu.
The Copy Asset To dialog box appears.

3. In the Save in field, enter a destination and click Save. To cancel, click Cancel.
Cumulus copies all files to the specified locations.

{button ,AL(`manage',0,`',`')}    See also 
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Routing Assets through E-mail 

Routing an asset through e-mail sends it as an attachment to an e-mail message. To route assets through e-mail 
you need to have an e-mail system compatible with the Messaging Application Programming Interface (MAPI).
To e-mail assets:
1. Select the record representing the asset to mail.
2. On the File menu, click Send Asset.

The Choose Profile dialog box appears.
3. Select a profile based on the e-mail system installed on your system.
4. To select a new information service, click New and follow the instructions.
5. To close the Choose Profile dialog box and accept the displayed profile click OK. To cancel, click Cancel.
{button ,AL(`manage',0,`',`')}    See also 
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Moving Assets 

Moving an asset from within Cumulus is a two-step process. Cumulus first copies the asset to a new location and 
then deletes it from the original location. Cumulus updates the catalog reference to reflect the new location. 
To move cataloged assets:
1. Select one or more records in the Record pane, or display the Record Properties dialog box.
2. From the Record menu, click Move Asset To.

The Move Asset to dialog box appears.
3. In the Save in field, enter a destination and click Save. To cancel, click Cancel.
4. Repeat step 3 for all selected assets.

Cumulus moves the files to the specified locations and updates all references.
{button ,AL(`manage',0,`',`')}    See also 
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Deleting Assets

Selecting the Also Delete Asset option in the Delete Records dialog box is a quick way to delete both the selected 
record and the original media file.
To delete both a record and the asset:
1. In the Record pane, select the record to delete.
2. From the Record menu, click Delete Record, or press DELETE.

The Delete Records dialog box appears.
3. Select Also Delete Asset and click Delete. To cancel, click Cancel.

Cumulus deletes the selected records and the original media files for those records.
{button ,AL(`manage',0,`',`')}    See also 
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Editing Assets

If you have a program installed that can edit an asset, you can use Cumulus to launch the program and open the 
file.
To edit a cataloged asset using another program:
1. Select one or more records in the Record pane.
2. From the Record menu or the Record pop-up menu, click Open Asset with, and then choose Associated Program

or Other.
Cumulus launches the program, which then opens the file.

{button ,AL(`manage',0,`',`')}    See also 
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Printing Assets from Other Programs

If you have a program installed that can print an asset, you can use Cumulus to launch the program and open the 
file. For an overview on printing, see Printing Information.
To print an asset using another program:
1. Select one or more records in the Record pane.
2. From the Record menu or the Record pop-up menu , click Print Asset with, and then choose Associated Program

or Other.
Cumulus launches the program, which then opens and prints the asset.

{button ,AL(`manage',0,`',`')}    See also 



Tailoring Cumulus
Customizing Application Preferences 
Setting Cataloging Options 



 Tailoring Cumulus 
Customizing Application Preferences 

The Application Preferences dialog box lets you customize and define general program behaviors such as:
• whether the program reopens the last-used catalog at startup
• how Cumulus displays records (Thumbnail or Details view)
• mouse double-click preferences
• whether certain warnings should appear or be suppressed
• display options (e.g., Record Properties dialog box behavior, desired measurement units, grid use during 

window resizing, and whether the Details window is enabled or disabled)
• general search behavior 
To view or alter your application preferences:
1. On the View menu, click Preferences.

The Application Preferences dialog box appears. 
2. Move from one tab to another by clicking a tab title.

General 
Display 
Search 

3. Make selections and click Apply. To activate all selections and exit the dialog box, click OK. To cancel, click 
Cancel.

{button ,AL(`customizing',0,`',`')}    See also 
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General Tab
The General tab controls general program behavior. 

Option Purpose
At Startup, Reopen 
Catalogs

Automatically reopens the last-used catalog at 
startup.

Open Catalogs Determines the appearance of the Record pane 
when a catalog is opened. Open Catalogs options
change the view of newly opened catalogs only. 
To alter the view of a catalog currently on-screen,
select the desired view from the View menu.
Available options include:
• As They Were Closed displays records as they 

appeared when the catalog was last closed
• In Details View displays records in a convenient 

table that lists the record name, format, color 
mode, resolution, and modification date

• In Thumbnail View displays records as graphical
thumbnails

• In Administration View displays a special 
window that monitors catalog activity. 

Double-click on 
Record

Determines what happens when you double-click 
a record. Available options include:
• Opens Record Properties displays the Record 

Properties dialog box 
• Opens Asset Preview displays a preview of the 

cataloged asset
Warning Dialogs Controls whether or not certain warning dialog 

boxes appear. Available options include:
• Show Warnings displays all warnings
• Suppress Warnings suppresses certain warnings

{button ,AL(`preferences',0,`',`')}    See also 
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Display Tab
The Display tab controls how catalogs and records are displayed and measured, and how the Record Properties 
dialog box behaves. 

Option/Field Purpose
Thumbnail View Determines if the record name is displayed in

Thumbnail view and/or if a Details window 
appears when the cursor is positioned over a
thumbnail. 

Preview Size Controls the size of an Asset Preview window.
Available options include:
• Original Size displays an Asset Preview 

using the actual size of the cataloged 
asset

• Fit to Main Window resizes the Asset 
Preview to fit the Cumulus Application 
window

• Other lets you enter the preferred Asset 
Preview size in the field provided

Measurement, Unit Determines the unit of measurement (e.g., 
inches, centimeters, etc.) that appears in the
Record Properties dialog box.

Record Properties Dialog 
Box, Always on Top

Always displays the Record Properties dialog 
box on top of all Cumulus windows.

Catalog Window, Use Grid
for Resizing

Automatically resizes the Record pane to 
minimize white space.

{button ,AL(`preferences',0,`',`')}    See also 
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Search Tab
Options on the Search tab affect how Cumulus locates records using the findbar and how categories display records.
Within Cumulus, the term search means more than using the findbar to locate records. When you click on a 
category to display records, the program performs a search to locate all records in that category. For more 
information on category searching, see Understanding Category Search Preferences. 
Under Category View Search Finds Records, you can select one of two search techniques:
• Matching At Least One Selected Category finds records associated with at least one of the categories selected 

in the Category pane.
• Matching All Selected Categories finds records associated with all categories selected in the Category pane.
Under Category Search Also Finds Records of, you can determine the category search scope. Selecting Categories 
Below the Selected enables the “and Related Categories” option, which lets you search for related categories as 
well as the ones specified by the search.
{button ,AL(`preferences',0,`',`')}    See also 
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Setting Cataloging Options

The Cataloging Options dialog box controls the way in which Cumulus catalogs assets and the kinds of information 
that are imported during cataloging. For information on altering Cataloging Options for existing records, see 
Updating Static Record Information.
Options in this dialog box include:
• whether to include automatically-assigned customized notes, status terms, and user names
• whether to automatically display the Record Properties dialog box as each asset is cataloged
• whether records should be associated with default categories 
• whether catalogs can have multiple records for the same asset
• which file filters are available and in what order
• how Cumulus creates thumbnails 
To display the Cataloging Options dialog box:
1. On the File menu, click Cataloging Options.

The Cataloging Options dialog box appears.
2. Move from one tab to another by clicking a tab title.

General 
Categories 
Assets 
File Formats 

3. Make selections and click Apply. To activate all selections and exit the dialog box, click OK. To Cancel, click 
Cancel.

{button ,AL(`customizing',0,`',`')}    See also 
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Cataloging Options, General Tab
The General tab allows you to specify default presets that Cumulus assigns every time you catalog an asset . Most 
of these presets can be edited later in the Record Properties dialog box. 

Option/Field Purpose
Records, Notes Entering text in the Notes field automatically adds 

note information to all new records during the 
cataloging process. You can view or edit notes in 
the Record Properties dialog box .

Records, Status Assigns the selected status to all new records 
during the cataloging process.

Every record can be assigned a user-defined 
status. By assigning a status, you can 
communicate a given condition or state about a 
particular asset. See Utilizing Record Status.

Records, User Assigns the name entered here as the user who 
cataloged the asset. 

While Cataloging, 
Include Notes from 
Asset

Automatically includes information stored in the 
original asset in the Notes field of the Record 
Properties dialog box during cataloging.. For 
example, the Compound Document Filter allows 
you to import statistics (i.e., word and character 
counts) stored in Microsoft Word documents. 

While Cataloging, 
Show Progress Bar Counts the total number of assets before starts 

the cataloging process. During cataloging, the 
Progress dialog box displays the asset file name 
and a percentage complete bar. This slows down 
the cataloging process.

After Cataloging, 
Open Property 
Window Automatically

Displays the Record Properties dialog box after the
creation of all new records. This lets you 
systematically update a record’s properties right 
after cataloging. 

{button ,AL(`catalog options',0,`',`')}    See also 
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Cataloging Options, Categories Tab
The Categories tab controls how Cumulus uses categories during the cataloging process. For more information on 
creating categories, see Creating New Categories.
The Assigning Categories While Cataloging options allow you to automatically associate records with categories. 
To assign preset categories:
1. From the Categories list, select the categories to assign automatically.
2. Click the Add button.
To remove an assigned category:
1. From the Preset Categories list, select the categories to remove.
2. Click the Remove button.
Enabling Include Categories from Asset automatically creates categories and assigns records based on keywords 
stored in the asset file. As you catalog an asset, Cumulus reads the keywords stored in the file. If categories already
exist that match the keywords, Cumulus assigns records to those categories. If not, Cumulus creates new categories
and then assigns the records to them.
Include Folder Names as Categories controls whether or not Cumulus automatically creates new categories that 
mirror the path to (or location of) the media file. Categories derived from folder names contain a small folder 
symbol. 
If you organize your assets in advance (e.g., into nested folders broken out by project or file type) you can catalog 
in one easy step. When you catalog an asset, Cumulus automatically creates new categories matching the path (or 
location) to the original media file. 
If you disable this option, you can still locate assets in one of three ways:
• display the Record Properties dialog box and look under Asset Location
• select the record and then click Explore Asset on the Record menu
• search for the folder name using the findbar 
{button ,AL(`catalog options',0,`',`')}    See also 
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Cataloging Options, Assets Tab
The Assets tab lets you specify how catalogs are updated, specify how to handle duplicates and shortcuts, and list 
specific asset files that should never be cataloged. 
When Cataloging determines if Cumulus catalogs new assets or updates existing records. You can choose from the 
following:
• Add Only catalogs only assets that have not yet been cataloged.
• Add and Update creates new records for assets that have not yet been cataloged and updates existing ones.
• Update Only updates only existing records. 
Under Duplicates, Add Duplicates allows duplicate records. Ignore Duplicates prevents an asset from being 
cataloged more than once.
When Collection Folder is enabled, you can copy all cataloged assets to a central collection folder. 
Under Shortcuts, Resolve Shortcuts directs Cumulus to use the path stored in a Windows operating system shortcut 
to locate an asset. Ignore Shortcuts disables this feature. For example, suppose you create a shortcut to an asset 
stored on another disk. If Resolve Shortcuts is enabled, you can catalog that asset by dropping its shortcut onto the 
Catalog window. 
Under When Cataloging, you can specify assets that should not be cataloged. Damaged or corrupt asset files cause 
common cataloging problems that may crash your system. If you know a specific asset file is causing problems, add
it to the Do not Catalog the Following Assets list. 
To automatically assign damaged files to the Do not Catalog... list, select Add Damaged Asset to List Automatically. 
This may slow down cataloging performance, so use this option only when you are unable to determine the file 
causing problems. When enabled, Cumulus keeps a record of the last file cataloged. If your system crashes, 
Cumulus automatically adds that file to the Do not Catalog the Following Assets list. 
To specify assets that should not be cataloged:
1. Click Add Asset to List.

The Open dialog box appears.
2. In the Open dialog box, select the asset and click Open.

The selected asset appears in the Do not Catalog the Following Assets list.
To remove assets from the Do not Catalog the Following Assets list:
1. Select the assets from the Do not Catalog the Following Assets list.
2. Click Remove Asset from List.

Cumulus removes the selected assets.
{button ,AL(`catalog options',0,`',`')}    See also 
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About Collection Folders
You can configure Cumulus to copy cataloged assets to a special folder (called a collection folder) on the Cumulus 
Server. Collection folders can be configured so that assets are copied either at your discretion or every time as 
asset is added to the catalog. 
The actual asset remains in the original location, but the record points to the copy in the collection folder. You can 
control who is allowed to modify assets stored in the collection folder.
You can enable or disable collection folders in the Catalog Properties dialog box. 
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Cataloging Options, File Formats Tab
From within the File Formats tab you can control how Cumulus utilizes file filters. All supported file formats appear in
the Cataloging File Formats list. 
Enabled filters have a small checkmark on the far left side. Each filter can support multiple file formats. Use the 
scroll bar to the right side of the list to review all entries. 
You can:
· reorder the filters
· enable/disable support for certain file formats
· add/remove filters
· determine the type of information Cumulus imports during the cataloging process (if supported)    
To determine the way in which filters import information:
1. In the Order column, highlight the file format entry and click Properties.
2. Within the Properties dialog box, click Properties.

If available, a setup dialog box appears.
3. After adjusting the available fields, click OK. To Cancel, click Cancel.
On this tab, you can also do the following:
Move formats up or down in the list 
Edit formats 
{button ,AL(`catalog options',0,`',`')}    See also 
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Moving Formats in the List
Click each column header (Order, Extension, File Format, or Filter) to toggle the file format order from ascending to 
descending order. 
To move individual formats, click the appropriate arrow button:

Arrow 
Button

Purpose

First
Moves the selected format to the top of the list.

Move
Up

Moves the selected format up one position within
the list.

Move
Down

Moves the selected format down one position 
within the list.

Last Moves the selected format to the bottom of the 
list.

 Setting Cataloging Options
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Editing File Formats
A checkmark appears next to all enabled file formats. Enabling a specific file format loads it into memory. Disabling 
file formats you rarely use improves program performance.
As Canto adds new file formats, you can download them free of charge from our website (http://www.canto-
software.com). To install and use a new format, download it and follow the online installation instructions. Once 
installed, the format appears in the Cataloging File Formats list, but must be enabled. 
To enable or disable a specific format:
1. Under the Order column, double-click the filter order number or highlight the file format to enable/disable and 

click Properties.
The File Format Properties dialog box appears.

2. Enable/disable the format by checking/unchecking Activate This File Format Entry.
3. To accept all changes, click OK. To cancel, click Cancel.
{button ,AL(`catalog options',0,`',`')}    See also 
You can add file formats to any existing file filter.
To add file formats using existing filters:
1. Under Cataloging File Formats, click Add.

The File Format Properties dialog box appears.
2. Enter the appropriate windows extension (e.g., *.eps) in the Windows Extension field.
3. Enter the appropriate format name in the Format field.
4. Select a filter from the Use Filter Control list.
5. If available, click Properties to customize the filter properties (see Controlling Filter Behavior).
6. To accept all changes, click OK. To cancel, click Cancel.
You can remove filter formats added after the initial product installation. You can not remove filters installed during 
the initial product installation. 
To remove a file format:
1. In the Order column, highlight the appropriate file format entry.
2. Click Remove.



{button ,AL(`catalog options',0,`',`')}    See also 
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Cataloging Options, Thumbnails Tab
The Thumbnails tab allows you to control the visual quality of thumbnails created during cataloging or record 
updating. Thumbnail dimensions are set in the Catalog Properties dialog box.
The right side of the Thumbnails tab displays a sample thumbnail so you can evaluate your quality and optimization
settings. The thumbnail’s dimensions (in pixels) appears directly above the image and are followed by the disk 
space that the thumbnail will occupy.
Under Quality, you can select the quality setting for the following:
• Line Art for assets that contain only two colors (i.e., black and white)
• Grayscale for assets that contain shades of gray
• Color for assets that contain color

Color 
Mode

Normal High

Line Art Black and White 4 shades of gray
Grayscale 256 shades of gray, 

lower quality JPEG
256 shades of gray, higher 
quality JPEG 

Color Millions of colors, 
lower quality JPEG 

Millions of colors, higher 
quality JPEG

If you enable Optimize Thumbnail, Cumulus automatically optimizes the appearance of each thumbnail during the 
cataloging process. You can also manually optimize thumbnails by selecting them in the Record pane and clicking 
Optimize Thumbnail on the Edit menu.
Under Create Thumbnail from you can specify one of two thumbnail creation methods:
• Stored Thumbnail (when available) quickly builds thumbnails from thumbnail information stored in the asset file

(if available). Although this creation method is the fastest, some thumbnails may be smaller than your specified
default thumbnail size.

• Entire Asset creates a thumbnail using all available file information. Although this method creates thumbnails 
that are consistent in size and quality, it may slow down the cataloging process significantly.

{button ,AL(`catalog options',0,`',`')}    See also 
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 Implementing Cumulus 
Using Sample Scenarios

The real power behind Cumulus lies in all the different ways you can use it to help simplify and manage your 
workflow. The following topics are examples of ways in which users have successfully implemented Cumulus into 
their organizations.
Scenario 1: Finding the right version of a logo 
Scenario 2: Distributing images 
Scenario 3: Multimedia Project Management 
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Scenario 1: Finding the right version of a logo
A graphic artist working in a small advertising agency needs to quickly locate a client logo for a new brochure. 

Problem
The logo was recently redesigned by another designer who is out sick. As a general rule, all current projects are 
stored in common folders and tracked using Cumulus.

Solution
The graphic artist uses Cumulus to instantly locate and download the logo she needs:
1. The graphic artist launches Cumulus and opens the catalog used for current projects.
2. She conducts a compound search for the Record name, Acme Corp Logo and the status, Approved.

The query finds three versions of the same logo.
3. She previews each record by selecting Preview from the Record menu.
4. Since two of the images appear identical, she reviews each record’s properties by selecting Properties from the 

Record menu.
5. She determines which image is the appropriate one by reviewing information stored in the Record Properties 

dialog box (e.g., the modification date and notes). 
6. She copies the image and imports it into her layout.
{button ,AL(`scenario',0,`',`')}    See also 
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Scenario 2: Distributing Images
A small digital imaging company sells stock photographs and illustrations for both Macintosh and Windows users. 
Images are distributed to customers on CD-ROM using a logical subject-oriented folder structure. Currently all 
images are stored on numerous JAZ cartridges. 

Problem
The company wishes to find an efficient, effective, easy-to-use way to track all images internally. In addition, the 
company wants to find a better way to distribute images to customers. 

Solution
The company’s creative director uses Cumulus to create a catalog of available images:
• The director catalogs all images.
• He creates record names for assets without meaningful file names.
• He creates related categories for images that might fall into more than one category.
• He annotates each record’s notes with the artist/photographer’s name, subject, or official title
Once the main catalog is complete, the creative director uses the Cumulus Browser to create another catalog for 
distribution. 
{button ,AL(`scenario',0,`',`')}    See also 
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Scenario 3: Multimedia Project Management
A small multimedia company creates interactive multimedia projects for numerous customers. Most projects include
image, sound, video, and multimedia authoring files (e.g., Director¨ or Authorware¨). The company has twelve full-
time employees and often uses multiple contractors.
Shared files are stored in folders by project and then file type. The catalogs are automatically backed up onto 
removable cartridges each night. Completed projects are archived on CD-ROM.

Problem
Because of the sheer number of files and file types used in multimedia projects, the company sometimes has 
problems with version control and often misplaces important files. In addition, quickly accessing archived projects 
stored on CD-ROM can be time-consuming. The company is looking for a better way to manage its assets.

Solution
The Senior Project Manager creates two catalogs: one for current projects and another for completed ones. Within 
the catalog for current projects, the staff completes the following tasks:
• Configure all Catalog properties (see the Cumulus Network 4 Administrator User Guide)
• Catalog all images and other project elements
• Add notes (when appropriate) to further annotate particular asset issues
• Assign status terms to records that describe the “state” of the project element
Within the catalog for completed projects, the project manager locates and catalogs the contents of all archived 
projects. Within each, he adds notes where appropriate to further annotate issues or details.
{button ,AL(`scenario',0,`',`')}    See also 
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Using the Cumulus Browser 

The Cumulus Browser is a royalty-free application that you can use to publish Cumulus catalogs on CD-ROM or other
removable media, such as SyQuest, Zip, Jaz, and MO cartridges. As a registered Cumulus user, you may distribute 
the Cumulus Browser either as a pre-installed application or with the installer included on your Cumulus CD-ROM 
disc. 
The Cumulus Browser offers all the functionality of the single-user version except:
• users can only create new catalogs that contain up to fifty records
• users can have only two catalogs open at once
For more information on using Cumulus Browser to distribute catalogs, see the Cumulus Network 4 Administrator 
User Guide.
{button ,AL(`distribution',0,`',`')}    See also 
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Using the Cumulus Internet Media Server

Cumulus Internet Media Server¨ is a powerful CGI (Common Gateway Interface) application designed for publishing 
and distributing media assets over the Internet. With Cumulus Internet Media Server, you can publish Cumulus 
catalogs on the Web and offer multiple users the ability to access, search, and download files. 
This powerful publishing tool offers hot-linked, hierarchical category lists. By selecting an item from a list, users 
trigger catalog searches for assets that they can then retrieve and download. 
In addition, Cumulus Internet Media Server also features the ability to:
• search a Cumulus catalog from any forms-capable browser on any platform (e.g., MacOS, Windows or UNIX)
• directly view and search on built-in hierarchical category lists
• work immediately with pre-formatted search and resolve templates
• save selected assets from multiple searches and place an order or initiate a 4-Sight ISDN transfer
• publish low-resolution previews of assets as well as full-quality versions
• control user access and download capability with Permissions settings
• track user previews and download them via a detailed transaction log
• customize the user interface with the program’s Template Definition Language
For more information on setting up the Cumulus Internet Media Server, see the Cumulus Network 4 Administrator 
User Guide.
{button ,AL(`distribution',0,`',`')}    See also 
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Automating Cumulus

Most tasks in Cumulus can be automated through Visual Basic and other OLE-automation-compliant programming 
tool, including: 
• Microsoft ActiveX scripting engines like VBScript and JavaScript
• Microsoft Visual Basic
• Microsoft Visual C++
• Microsoft Visual J++
• Borland Delphi
• PowerSoft PowerBuilder
A selection of Visual Basic automation applications are included with the default installation and more specialized 
scripts are included in the folder More Scripts.
The extent to which you can successfully integrate Cumulus in your workflow depends on whether or not the 
applications you use on a regular basis are OLE-automation-compliant. Please check our website for the most recent
information about Cumulus automation (http://www.canto-software.com).
Cumulus is OPI-aware and able to read path name information and manage both high-resolution and low-resolution 
file information from OPI products like Luminous Color Central, NineBits PrintDesk, 4-Sight OPI, and Helios 
EtherShare OPI. 
Clients can place low-resolution files in Adobe PageMaker, or other layout applications, and Cumulus will 
automatically provide the high-resolution files for editing, even though the low-resolution file was cataloged.
Cumulus is also OPI-compatible with many other OPI systems like Scitex APR that use EPSF files as the low-
resolution file. Layout files are handled as expected, but the path to the high resolution file might not be 
automatically recognized.



 Implementing Cumulus 
Using Vento

Cumulus includes a powerful folder-watching utility called Vento. Vento watches a folder or nested folder hierarchy 
that resides on local Windows NT volumes. Windows 95 is not supported. If an asset is added to, changed, or 
deleted from the folder structure, Vento triggers an automation application of your choice. 
Vento ships with an executable that automatically updates a Cumulus catalog. This script can be easily modified to 
perform other tasks and control other OLE-automation-compliant applications. For more information, see the Vento 
documentation in the Vento folder, included in the standard Cumulus installation.



 Implementing Cumulus 
Using the Automation Included with Cumulus

The following section details the different automation scripts (or applets) that are included with Cumulus. These 
applets may give you some ideas about how you can apply Cumulus automation to your workflow. The source code 
for all applets described here is included, so you can change it to adapt to your local processes.
Any applet can be made available as a menu command within Cumulus, extending its basic functionality. Place the 
executable into the Scripts folder in the Cumulus Client folder and restart Cumulus. Cumulus makes all scripts in 
this folder available in the Scripts menu.
Automation scripts included with Cumulus can be found in two locations: 
• The Scripts folder contains applets of general interest. 
• The More Scripts folder contains applets of a more specialized nature.
Either can be installed in the Scripts menu by dragging it into the Scripts folder. Cumulus makes additions to the 
folder available the next time you launch the Cumulus Client application.
Please check our website for the most recent information about Cumulus automation (http://www.canto-
software.com).
Applets included with Cumulus fall into the following categories:
Automatic cataloging 
Records and Categories 
Maintaining File References 
DCS File Management 
Searches 
Import/Export 
Optimization and Statistics 
Application Integration 
{button ,AL(`automation',0,`',`')}    See also 
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 Automation Included with Cumulus

Automatic Cataloging
Hot Folder is a script that watches a single folder. Any new assets added to the folder are cataloged into the active 
Cumulus catalog. 
To use Hot Folder:
1. Start the Hot Folder application and choose a folder or drop a folder onto its icon.
2. Enter the number of seconds Hot Folder should wait between each check of the folder contents.
Canto recommends using Vento to keep a catalog consistent with the contents of a folder or group of folders.
{button ,AL(`automation',0,`',`')}    See also 
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Records and Categories
Cumulus includes several automation applets that simplify the task of managing large quantities of records. They 
appear on the Scripts menu when they are available. These applets include:
Assign Multiple Categories 
Assign Status to Records 
Join Duplicate Categories 
New Category from Current Date 
Delete Record and OPI Files 
{button ,AL(`automation',0,`',`')}    See also 
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 Records and Categories

Assign Multiple Categories
Assign Multiple Categories assigns all records selected in the Record pane to the categories selected in the 
Category pane.
To use Assign Multiple Categories:
1. Select the records to assign to a group of categories.
2. Select a group of categories.
3. On the Scripts menu, click Assign Multiple Categories.
{button ,AL(`automation',0,`',`')}    See also 



 Automation Included with Cumulus
 Records and Categories

Assign Status to Records
Assign Status to Records assigns a common status to multiple selected records. You can also automatically assign 
status terms in the Cataloging Options dialog box.
To use Assign Status to Records:
1. In the Record pane, select the records to which you want to assign a common status.
2. On the Scripts menu click Assign Status to Records.
3. Type the status you wish to assign to the records. 

Part of the current status list is shown in the input field to help you select your status. You must spell the status
exactly as it appears in the status list.

{button ,AL(`automation',0,`',`')}    See also 
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 Records and Categories

Join Duplicate Categories
Join Duplicate Categories looks for duplicate categories in the active catalog. If it finds duplicate categories, the 
application reassigns all records to the first category. It then renames all other categories to indicate that they are 
duplicates and offers you the option of deleting them.
{button ,AL(`automation',0,`',`')}    See also 
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New Category from Current Date
New Category from Current Date creates a new category with the current date as its name.
{button ,AL(`automation',0,`',`')}    See also 
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 Records and Categories

Delete Record and OPI Files
Delete Record and OPI Files deletes all selected records and their respective high resolution files and OPI layout 
files. Cumulus asks whether the OPI file should be recognized by file extension or by subfolder location. 
{button ,AL(`automation',0,`',`')}    See also 
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Maintaining File References
File references point to the location of the original media files. Cumulus stores a file reference in the record of each 
cataloged asset. Whenever you move assets, make sure that these file references are kept up to date. If you always
move assets with Cumulus, the file references will stay up to date. 
The following scripts can help you perform more complicated asset movements or update references for assets that
were moved without using Cumulus:
Check After Folder Has Moved 
Redirect File Reference 
Move Folder 
{button ,AL(`automation',0,`',`')}    See also 
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Check After Folder Has Moved
Check After Folder Has Moved updates the file references of all records pointing to assets in a folder that has been 
moved to a different location. It searches for all records that may be involved and then checks for the folder names 
to match with the old folder. 
{button ,AL(`automation',0,`',`')}    See also 
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Redirect File Reference
Redirect File Reference redirects the file references for selected records to new asset locations. 
To use Redirect File Reference:
1. Select the records for which you want to change the file reference.
2. From the Scripts menu, choose Redirect File Reference and locate the asset corresponding to each record you 

are updating.
If the asset in the new location has a modification date later than the date stored in the record, Cumulus asks if it 
should update the record accordingly.
{button ,AL(`automation',0,`',`')}    See also 
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Move Folder
Move Folder moves a folder and all its subfolders in the operating system and updates the corresponding Cumulus 
records at the same time. 
To use Move Folder:
1. From the Scripts menu, choose Move Folder and locate the folder to be moved.
2. After you select the folder, you are asked to locate a destination.
3. Cumulus moves the folder and all subfolders to the new location. 

Any records in the active catalog that refer to the moved assets are updated to refer to the new location.
If the asset in the new location has a modification date later than the date stored in the record, Cumulus asks if
it should update the record accordingly.

{button ,AL(`automation',0,`',`')}    See also 
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DCS File Management
The DCS file format consists of five files: a composite preview file in low resolution and four monochrome files that 
correspond to the Cyan, Magenta, Yellow, and Black printing plate colors. Cumulus records of DCS 1.0 files refer only
to the composite file. Use the following applets to copy, move, find, and delete all five files at the same time. These 
applets work equally well with files that are not DCS 1.0 files. If you wish to copy or move many files, you may find 
that these applets are faster than the Cumulus menu commands.
Copy DCS Files to Folder copies the files corresponding to every selected record to a new location.
Delete DCS Files deletes all files corresponding to every selected record, asking for confirmation before executing. 
Move DCS Files to Folder moves all files of every selected record to a new location.
{button ,AL(`automation',0,`',`')}    See also 
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Searches
These applets enable Cumulus to perform searches that are not readily available with the findbar or by browsing 
the Category pane:
Find Same Categories 
Live Search 
{button ,AL(`automation',0,`',`')}    See also 
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 Searches

Find Same Categories
Find Same Categories finds all records assigned to the same categories as the selected records. A dialog asks you 
to choose whether to search for records matching each category or any of the categories to which the records are 
associated.
{button ,AL(`automation',0,`',`')}    See also 
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Live Search
Live Search takes the last search query you executed from the Cumulus findbar and applies it at regular intervals to
the active catalog. When using this applet, do not copy it to the Scripts folder. Instead, launch it as a separate 
application from within Windows Explorer.
To use Live Search:
1. Compose a search query in the findbar. 
2. Click the Find button.
3. Launch Live Search from within Windows Explorer.

A dialog box appears and asks for the number of seconds to wait between searches.
{button ,AL(`automation',0,`',`')}    See also 
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Import/Export
The Import/Export applets allow you to automatically export and import record, category, or query information to a 
tab-delimited text file, which can then be imported into other catalogs or applications. For more information on 
importing and exporting information, see Exporting and Importing Information. Import/export applets include:
Categories to Text 
Text to Categories 
Export To MS Access 
Export to Tab Delimited File 
Thumbnails to BMP Files 
BMP File to Thumbnail 
Note: For Windows, BMP files are converted to bitmap files and renamed properly.
{button ,AL(`automation',0,`',`')}    See also 
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Categories to Text
Categories to Text writes the category structure of the active catalog to a text file. Each category is indented by a 
number of tabs corresponding to its level in the hierarchy. You can save the document to a text file and import it 
into another catalog using the Text to Categories applet.
{button ,AL(`automation',0,`',`')}    See also 
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Text to Categories
Text to Categories imports a list of categories from a text file. The text document contains each category on a single
line indented by tabs that correspond to the appropriate category level. The script reads each line and creates new 
categories in the active catalog. 
{button ,AL(`automation',0,`',`')}    See also 
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Export To MS Access
Export To MS Access copies information from Cumulus records into a Microsoft Access database. The MS Access 
database must contain fields that match those in the installed 
Cumulus -> MS Access DB database.
To export Cumulus records to MS Access:
1. Make a copy of the Cumulus -> MS Access DB database.
2. Start MS Access.
3. Select the records to export to the MS Access database.
4. Run Export To MS Access. 
5. Select the MS Access database file in the dialog that appears. 

The script creates records in the MS Access database that correspond to each selected record in Cumulus.
{button ,AL(`automation',0,`',`')}    See also 
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Export to Tab Delimited File
Export to Tab Delimited File creates an export file containing each selected record of the active catalog. The 
resulting file contains a line of column names and the information for each selected record in a tab-delimited line 
format. Thumbnail and type-specific information are not exported.
To use Export to Tab Delimited File:
1. Select the records you want to export.
2. From the Scripts menu, choose Export to Tab Delimited File.
3. In the dialog that appears, specify a file name and location for the export file.
{button ,AL(`automation',0,`',`')}    See also 
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Thumbnails to BMP Files
Thumbnails to BMP Files creates a new BMP file for each selected record of the active catalog and writes its 
thumbnail to it. 
To use Thumbnails to BMP Files:
1. Select the records for which you want to export the thumbnails.
2. From the Scripts menu, choose Thumbnails to BMP Files. 

For each selected record, specify a name and location for the BMP file to create. The default name is the file 
name corresponding to the record.

{button ,AL(`automation',0,`',`')}    See also 
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BMP File to Thumbnail
BMP File to Thumbnail uses the contents of a BMP file as a thumbnail for a single record.
To use BMP File to Thumbnail:
1. Select the record for which you want to create the thumbnail.
2. From the Scripts menu, choose BMP File to Thumbnail. 
3. In the dialog that appears, select the BMP file you want to use. 

The script replaces the thumbnail of the selected record with the picture from the BMP file.
{button ,AL(`automation',0,`',`')}    See also 
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Optimization and Statistics
Cumulus includes applets for optimizing your cataloging process and for getting information about the records in 
your catalog. 
Set Up Catalog for Speed optimizes the Cataloging Options so that Cumulus will catalog assets as fast as possible. 
The script will ask you to confirm any changes to the settings.
Set Up Catalog for Safety optimizes the database settings and cataloging options to prevent data loss. You are 
prompted before any changes are made to your settings.
Count File Formats creates a new text window and lists the different File Formats referenced by the active catalog, 
and the number of records for each type. 
{button ,AL(`automation',0,`',`')}    See also 
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Application Integration
There are many ways to integrate Cumulus into other OLE-automation-compliant applications. We have included the
following scripts to get you started and encourage you to visit our website periodically (http://www.canto-
software.com) to learn about additional solutions as they become available.
Go To Web Page searches for the first appearance of an URL inside of the Notes field and opens the default browser 
to connect to the URL. The URL must start with http:// and end with the name of the referenced page.
{button ,AL(`automation',0,`',`')}    See also 
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 Troubleshooting 
Solving Common Problems 

This section contains frequently-asked questions and their possible solutions. If you have a problem not covered in 
this chapter, be sure to review Support & Solutions on the Canto Software website for additional troubleshooting 
information (http://www.canto-software.com).
· Can I change the way thumbnails appear? 
· How can I distribute my Cumulus catalog and media files on CD-ROM? 
· Sometimes when I copy or place an asset, it doesn  ’  t work or I get the wrong one. What do I do?  
· Whenever I request a file from Cumulus, it always asks me to mount a CD-ROM. Can I avoid this? 
· I used drag-and-drop to place files. The destination was highlighted but nothing happened when I released the 

mouse button. What went wrong?
· I updated all of my records to include new file content, but nothing happened. Why? 
· How do I export catalog information to another program? 
· New categories appear in the Category window when I drag and drop between catalogs. Why?
· I added keywords and notes before cataloging. Can Cumulus read this information during cataloging?
· How do I work with DCS separation files in Cumulus? 
· If I catalog my low-resolution OPI files, place them in documents, and print them, will Cumulus substitute the 

high-resolution files during printing?
· My converted Shoebox catalog no longer asks for CD-ROMs to be inserted when accessing files in Cumulus. 

What happened?



 Solving Common Problems 
Can I change the way thumbnails appear?

You can change the actual size (in pixels) of a thumbnail. You can also change a thumbnail  ’  s appearance   within the 
Record pane by selecting options found in the View menu and on the Thumbnails tab.



 Solving Common Problems 
How can I distribute my Cumulus catalog and media files on CD-
ROM? 

The Cumulus Browser is a royalty-free application that you can use to publish Cumulus catalogs on CD-ROM or other
removable media. See Using the Cumulus Browser. For procedures on distributing a catalog with the Cumulus 
Browser, see the Cumulus Network 4 Administrator User Guide.



 Solving Common Problems 
Sometimes when I copy or place an asset, it doesn't work or I 
get the wrong one. What do I do?

The reference to the asset is no longer up-to-date. If you know where the original file is located, update the file 
reference by selecting Update Asset Reference from the Record menu. 



 Solving Common Problems 
Whenever I request a file from Cumulus, it always asks me to 
mount a CD-ROM. Can I avoid this?

Cumulus can manage assets on various types of media, including off-line removable media such as CD-ROM or 
SyQuest, Zip, Jaz, and MO cartridges. You can reduce the number of mounting requests and interruptions by storing 
assets you use frequently on your hard drive.



 Solving Common Problems 
The destination was highlighted but nothing happened when I 
released the mouse button. What went wrong?

You probably don’t have access to the original media file you’re trying to place. 
To work around this problem, check the reference Cumulus uses to locate the file. By checking a file reference, 
Cumulus verifies that the asset is still located in the same place it was when it was cataloged. If Cumulus cannot 
find it, a dialog box appears so you can specify a new location. You must have access to the original media files to 
check file references.
To check a record’s file reference:
1. In the Record pane, select the records to check.
2. On the Record menu, click Update Asset Reference.

Cumulus checks (or resolves) all file references. 
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I updated all of my records to include new file content, but 
nothing happened. Why?

Updating records or forcing updates refreshes the thumbnail and updates static information that appears in the 
Record Properties dialog box. Any customized information is not updated.
Customized information can be added to existing records only by adding it to the Notes field or by recataloging the 
files. 
To automatically include note information as you catalog media files, enable While Cataloging, Include Notes from 
Asset in the Cataloging Options dialog box.



 Solving Common Problems 
How do I export catalog information to another program?

Cumulus supports the ability to export record and category information to a tab-delimited text file, which can then 
be imported into other catalogs or applications. For more information, see Exporting and Importing Information.



 Solving Common Problems 
New categories appear in the Category window when I drag and 
drop between catalogs. Why?

Every Cumulus catalog can have a different category structure that contains different categories. When you drag or 
import a record to another catalog, it may be assigned to categories that don’t exist in the destination catalog. If 
that is the case, Cumulus automatically creates the missing categories in the destination catalog.
To avoid this situation, copy the categories from one Category window to the other before importing records.



 Solving Common Problems 
I added keywords and notes before cataloging. Can Cumulus 
read this information during cataloging?

Yes, Cumulus is able to read notes and keywords out of a file automatically, if the information is stored in a standard
way. 
To automatically include note information as you catalog media files, enable While Cataloging, Include Notes from 
Asset in the Cataloging Options dialog box.



 Solving Common Problems 
How do I work with DCS separation files in Cumulus?

DCS 1.0 files consist of 5 different files: the master file and the four color separation files for Cyan, Magenta, Yellow, 
and Black. Cumulus catalogs only the master file to avoid creating 5 records for a single image. See DCS File 
Management.



 Solving Common Problems 
Will Cumulus substitute high-resolution files for cataloged low-
resolution OPI files?

Cumulus is fully compatible with many OPI systems and can form the backbone of a successful automation system 
in any environment. For more information, see Automating Cumulus.



 Solving Common Problems 
My converted Shoebox catalog no longer asks for CD-ROMs to 
be inserted when accessing files in Cumulus. What happened?

Kodak Shoebox keeps different information about the file location in its catalogs. This information cannot be used to
create a complete Cumulus file reference. Only the pathname of the file can be stored.
To get complete file references in Cumulus, check the file references for each CD-ROM that is managed by the 
catalog. For more information, see Checking File References.



 Troubleshooting 
Documenting Problems

When Cumulus behaves in an unexpected way or does not work properly, please try to reproduce the error, paying 
special attention to the actions you took prior to the problem. If there are many steps, write them down so you can 
tell us exactly what you did. 
If you cannot resolve your problem, please make a photocopy of the technical support form (see “Helping Us Help 
You” in your manual) so you can send it to your support provider. For information on contacting technical support, 
see Technical Support, or look under Support & Solutions on the Canto Software website (http://www.canto-
software.com).



Cumulus Administration
You can:
· Register the Cumulus software 
· Create a catalog 
· Create and open a new catalog 
· Add a catalog 
· Modify catalog properties 
· Back up a catalog 
· Restore a catalog you backed up 
· Recover deleted records 
· Compress catalogs 
· View administrative information and save catalog logs 
· Copy catalogs 
· Divide catalogs 
· Merge catalogs 
· Archive catalogs 
· Repair a catalog 
· Automate Cumulus 
If you have a client/server version of Cumulus, as well as the Desktop version, you can:
· Use the Catalog Access dialog box 
· Log on to the server 
· Disconnect clients 
For information on solving problems, see Troubleshooting and Technical Support.
{button ,AL(`administrator',0,`',`')}    See also 



 Cumulus Administration
Registering the Cumulus Software

You can register your copy of the Cumulus software in one of two ways:
· To print a registration form and mail or fax it to Canto, choose Print Registration from the Help menu.
· To register electronically, choose WWW Registration from the Help menu, fill out the form onscreen, and email 

to Canto.
{button ,AL(`administrator',0,`',`')}    See also 



 Cumulus Administration
Creating Catalogs 

The steps involved in creating a catalog are as follows: 
2. In the Catalog Access dialog box, click New.

The Create Catalog dialog box appears.
2. In the File Name field, enter the location where the catalog will be stored.
3. In the Catalog Name field, enter an optional Catalog Name.

Assigning a Catalog Name comes in useful if the asset file name has no meaning or it your operating system 
has strict naming restrictions.

4. Click OK. 
You can also do the following:
· Configure the catalog 
· Customize Application Preferences 
· Set Cataloging Options 
You may want to create multiple catalogs if you encounter any of the following conditions:
· Assets fall into logically unrelated groups. 
· The catalog file size becomes too large. Cumulus catalogs are limited to 2 GB. The number of records this 

permits depends upon the thumbnail quality/size settings and the amount of text in each record (e.g., in the 
Notes field)

{button ,AL(`administrator',0,`',`')}    See also 



 Cumulus Network Administration
Creating and Opening a New Catalog 

You can create and open a new catalog file using the New command on the File menu.
To create and open a new catalog:
1. From the File menu, choose New.
2. Enter a new catalog name in the File Name field and click Save.



 Cumulus Network Administration
Using the Catalog Access Dialog Box 

The Catalog Access dialog box is the starting point for performing numerous of administrative tasks. The Catalog 
Access dialog box has the following options:

Open Opens existing catalog files. Opening a catalog as the 
Cumulus Administrator is the first step to modifying 
catalog preferences.

New Creates new catalog files.
Add Add catalogs to the list appearing in the Catalog 

Access dialog box. To make catalogs available to 
clients, enable Share Catalog.

Remove Removes catalogs from the list Cumulus Clients see 
when logging on the Cumulus Server. If one or more 
clients are still connected, the Disconnect Client 
dialog box appears. 

Restore Opens backup copy of a catalog and restores it to the 
specified catalog file.

Properties of 
Selected 
Catalog, Share 
Catalog

Enabling this option makes a catalog available to 
Cumulus Clients.
For more information, see Creating Catalogs.

Properties of 
Selected 
Catalog, Publish
Catalog to 
Internet

Enabling this option is the first step to publishing a 
catalog on the Internet. 

{button ,AL(`administrator',0,`',`')}    See also 



 Cumulus Network Administration
Logging On to the Cumulus Server

The first step in creating a catalog is to log on to the Cumulus Server as the Cumulus Administrator. 
To log on to the Cumulus Server from a Windows Client:
1. Click the Start button, point to Programs and select Cumulus and then Cumulus Network Client.

Cumulus Client loads and the Connect to Server dialog box appears.
2. To alter or enter your server’s TCP/IP Port Number, click Options. 

The Connect Options dialog box appears.
3. To accept the default setting, click OK. To enter a new port number, type the port number and click OK. To 

restore the default port number, click Default and click OK. To cancel, click Cancel.
To be able to connect to the server, every client must specify a port number. By default, the port number is 
39287. Change the port number only to avoid a conflict with other server software.

4. Under Connect to, select the server you wish to connect to.
5. Under Connect as, select Registered User. 
6. Type CumulusAdmin in the Name field and cumulus in the Password field. 
7. Click OK.

Note: For more information on the default administrator user name and password, see the Cumulus Network 4 
Administrator User Guide.
The Catalog Access dialog box appears. It lists all currently open catalogs. Catalogs that are not shared (that is,
not available to clients) appear in italic.

{button ,AL(`administrator',0,`',`')}    See also 



 Cumulus Network Administration
Disconnecting Clients

You disconnect clients when you perform various database repair operations, such as removing, compressing, ore 
restoring catalogs. When you disconnect clients, you can specify the time period before they are removed and the 
message they see when they are removed.
To disconnect clients:
1. When the Disconnect Clients dialog box is displayed, enter a number of minutes in the text box.
2. Enter a message in the Message field. 
3. Click OK.



 Cumulus Administration
Configuring a Catalog 

You can configure:
· how Cumulus saves catalogs
· whether to enable or disable the Cumulus log
· the maximum number of entries (or records) a catalog may have
· whether to use a collection folder and save cataloged assets to a special location
· the default thumbnail size
· whether to allow duplicate category names
· permissions and access
All catalog configuration is controlled from the Catalog Properties dialog box. 
To view or alter catalog properties:
1. On the Administration menu, click Catalog Properties.

The Catalog Properties dialog box consists of three tabs: 
· General 
· Catalog 
· Sharing 
Move from one tab to another by clicking the tab title.

2. Make selections and click Apply. To activate all selections and exit the dialog box, click OK. To cancel, click 
Cancel.

{button ,AL(`administrator',0,`',`')}    See also 



 Cumulus Administration
 Configuring a Catalog 

Catalog Properties, General Tab
The General tab includes the following options:

Option Purpose
Catalog, File Location and file name of current catalog file.
Catalog, Name Catalog name that appears to clients. This name 

may differ from the actual file name.
Catalog, Save 
Changes

Determines how Cumulus saves changes made 
to catalogs. Available options include:
· Save Changes Immediately writes index 

changes to disk right away.
· Save Changes Later writes index changes to 

disk later. This option is faster, but less 
secure. If your system crashes, you may 
have to rebuild the catalog.

Catalog, Keep 
Deleted Records
Recoverable

Hides deleted records, but does not remove 
them from the catalog. By selecting Recover 
Deleted Records from the Administration 
menu, you can quickly recover all records.

Log Records client activity in a log file. 
If you turn this option on, enter a number in the 
Maximum Number of Entries field to specify the 
number of log entries Cumulus keeps in a RAM-
based log and displays in the Administration 
window. The RAM-based log is not saved when 
you close the catalog, unless specified with the 
Save Log to File option (below).
For more information, see Monitoring Catalog 
Activity.

Save Log to File Available options include:
· Save Log to File saves log entries to a 

specified file name and location when the 
catalog is closed. To use this option, click 
Log File and enter a name and location. 
Maintaining a large log file increases the 
time it takes to open a catalog, but provides 
a continuous list of activity. The file-based 
log adds entries until you turn off Save Log 
to File. 

· Flush File Constantly saves entries to the log
file as soon as changes are made.

{button ,AL(`administrator',0,`',`')}    See also 
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 Configuring a Catalog 

Catalog Properties, Catalog Tab
The Catalog tab includes the following options:

Copy Assets to Collection Folder Allows you to copy cataloged assets to a special folder called a 
collection folder on the Cumulus Server. Available collection 
folder options include:
· Never disables collection folder functionality.
· As Set in Cataloging Setting allows each client to determine 

whether cataloged files should be copied to a collection 
folder or remain in their original location. If you choose this 
option Cumulus asks you to specify a collection folder.

· Always configures Cumulus to always copy cataloged assets 
to the collection folder. When you select this option, Cumulus
asks you to specify a collection folder. 

Thumbnail Size Sets the default thumbnail size for the current catalog (96 x 96, 
128 x 128 and 192 x 192 pixels). Larger thumbnails offer more 
detail, but small thumbnails need less space.
The thumbnail size you select becomes the default size for the 
catalog. You can still view thumbnails at different sizes, but each 
view is scaled from the size at which the thumbnail was created. 
If you change the default size, existing records in the catalog do 
not change, but thumbnails for new records are created 
according to the new setting unless you update them.

Category Names Controls how Cumulus handles duplicate categories. Available 
options include:
· Keep Category Names Unique allows Cumulus to use the 

same name for multiple categories. When typing duplicate 
category names, you must include the full path. Otherwise, 
Cumulus will use the first category it finds. The path is not 
required when using drag and drop.

· Allow Duplicate Names prevents category name duplication. 
If you try to assign a name that is already in use, Cumulus 
displays a warning. Enabling this option does not affect 
existing categories.

{button ,AL(`administrator',0,`',`')}    See also 



 Catalog Tab
To update existing records to a new thumbnail size
1. Select the record you wish to update.
2. On the Record menu, click Update and then Always. 

Cumulus creates new thumbnails for the selected records.
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 Configuring a Catalog 

Catalog Properties, Sharing Tab 
Sharing enables you to set a password for the current catalog. All other options are disabled for the Desktop version
of Cumulus.

Password for Write Access Sets the password for creating a write-protected catalog. 

 Cumulus Network Administration
The Write Access Password (administrator only)

You set the password for write access in the Catalog Properties dialog box, on the Sharing tab.
The Write Access Password sets the password for creating a write-protected catalog. 



 Cumulus Administration
Monitoring Catalog Activity

You can monitor catalog activity from the Administration window, which displays:
· when a catalog is opened and closed
· what records are added, deleted or modified
· when assets are transferred
· if categories are modified
· if the status list is modified
You can:
View administrative information 
Save a log file 
Clear the log file 
{button ,AL(`administrator',0,`',`')}    See also 
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 Monitoring Catalog Activity

Viewing Administrative Information
Administrative information is displayed in an Administration View.
To access an Administration view:
· Open a catalog and select Administration from the View menu. 

The Administration window appears.
All current users appear under the User column on the far left side of the window. The right side of the window 
shows a detailed listing of catalog activity. To adjust the column headers, drag them right or left.
The top of the window offers other valuable information including:
· records deleted
· catalog memory free
· available disk space (see Elements Determing Record Size)
· memory available, required and recommended
To make the Administration View the default view:
1. On the View menu, click Preferences.

The Application Preferences dialog box appears.
2. Click the General tab.
3. Under Open Catalogs, select In Administration View.
{button ,AL(`administrator',0,`',`')}    See also 
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 Monitoring Catalog Activity

Saving a Log File
You can save a log file to a text file. This text file is a snapshot of catalog activity. You set up the log file in the 
Catalog Properties dialog box. If you choose a log file in Catalog Properties, the log file is generated automatically 
while Cumulus server (or Desktop) is running, but the information is not in readable format unless you save it to a 
text file using Save Log.
To save a log file:
· Choose Save Log from the Administration menu.
{button ,AL(`administrator',0,`',`')}    See also 
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 Monitoring Catalog Activity

Clearing the Log File
You can clear the current log file to erase all information from it and start over. You may want to save the current log
file before you clear it.
To clear the log file:
· Choose Clear Log from the Administration menu.
{button ,AL(`administrator',0,`',`')}    See also 
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 Monitoring Catalog Activity

Elements Determining Record Size
An empty Cumulus catalog is 590 KBs in size and requires about 80 KBs of RAM. To ensure fast searching and 
retrieval of information, Cumulus indexes all record data. This index grows as the number of records in the catalog 
increases and can become quite large for records that contain a lot of text.
Three main elements determine the record size:
· basic file information

Cumulus automatically captures specific types of information during the cataloging process. Basic file 
information is one of the smallest parts of a record and does not vary significantly in size.

· file-type-specific information
Certain file types can contain additional information that Cumulus saves during cataloging. Available only for a 
specific file types, this information can include font lists used in a file, the languages used in a movie, or other 
relevant details. File-type-specific information can be viewed in the Record Properties dialog box. 

· text in the Notes field
To ensure fast searching and retrieval of information, Cumulus indexes all record data, including text in the 
Notes field. Unusually large notes can slow down cataloging performance. Keep notes as brief as possible and 
avoid using unneeded words like the, a or an. You can enter up to 32 KB of information into the Notes field, but 
cataloging speed decreases as the amount of text increases. 

· thumbnail size and quality
The thumbnail size that you select when setting up your catalog influences the size of a typical record and thus
overall performance. Since Cumulus uses JPEG compression for grayscale and color thumbnails, the size of 
individual records varies depending on the thumbnail content. Higher quality thumbnails typically create larger 
records
For example, a catalog having 4,000 records and thumbnail quality of 128 x 128 pixels is approximately 50 MB 
in size. The same catalog with thumbnail quality of 192 x 192 pixels is 70 MB in size.
Disk Space Requirement for Thumbnails Created at 96 x 96 Pixels

Color
Mode

Normal High

Line 
Art

428 1247

Grays
cale

1392 2998

Color 1455 3612
Disk Space Requirement for Thumbnails Created at 128 x 128 Pixels

Color
Mode

Normal High

Line 
Art

962 1955

Grays
cale

1795 4374

Color 1909 5250
Disk Space Requirement for Thumbnails Created at 192 x 192 Pixels

Color
Mode

Normal High

Line 
Art

1910 3366

Grays
cale

2700 7660

Color 2849 9316
{button ,AL(`administrator',0,`',`')}    See also 
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Compressing Catalogs

Deleting or changing records creates unused space in a catalog. Although unused space does not decrease catalog 
performance, it can make a catalog unnecessarily large. You can reclaim this unused space by compressing the 
catalog.
While a catalog is being compressed it cannot be shared with clients. You should compress a catalog when it is not 
being used.
Compressing permanently deletes records from a catalog. After you compress the catalog, you will not be able to 
recover previously deleted records. 
To compress the catalog from a Windows Client:
1. On the View menu, select Administration. 
2. From the Administration menu, click Compress. 

A confirmation dialog appears. It tells you if you have recoverable records that will be lost through 
compression.

3. Click OK to proceed.
If any clients are still using the catalog, Cumulus asks you to disconnect them.
Cumulus compresses the catalog. The amount of time this takes depends on the size of the catalog and the 
amount of space to reclaim. 

{button ,AL(`administrator',0,`',`')}    See also 
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Backing Up and Recovering Catalogs

You can back up a catalog by copying it to another location. Cumulus Backup Files end with the file extension .bak. 
Recovering catalogs with Backup Copy takes longer than from a manually copied backup file.
To back up a catalog by copying it to another location:
1. Close the catalog you want to back up.

This ensures that any changes are saved to the catalog file.
2. Select the catalog file in Windows Explorer.
3. Copy the catalog to a backup location on a separate volume or drive.
To use the Backup Copy command:
1. Open the catalog you want to back up.
2. On the Administration menu, click Backup. 
To recover a catalog from a backup copy:
1. For best performance, move the backup copy to your hard disk.
2. Double-click the backup copy. 

A dialog box indicates that this is a backup copy:
3. Click Yes to create a new catalog from the backup copy. 

A dialog box asks you to save the new catalog.
4. Enter a name and location for the new catalog, and click OK. 

Cumulus rebuilds the catalog and its index information. The amount of time this takes depends on the number 
of records in the catalog as well as the speed of your hard drive.

{button ,AL(`administrator',0,`',`')}    See also 



 Cumulus Administration
Recovering Deleted Records

You can recover deleted records from a catalog if:
· You enabled Keep Deleted Records Recoverable. 
· The file was not deleted along with the record. If the original file was deleted, the record cannot be recovered.
· The catalog was not compressed after the records were deleted.
To recover deleted records:
1. Open the catalog.
2. From the Administration menu (Windows), click Recover Deleted Records.

Cumulus recovers all available deleted records and displays them in the Catalog window. You can browse them 
and delete the ones you do not need.

{button ,AL(`administrator',0,`',`')}    See also 
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Copying Catalogs 

You can copy, divide or merge catalogs without affecting the original assets. 
Copy or move a Cumulus catalog as you would any other file, but be aware of the following:
· Do not move or copy a catalog file while it is open. Doing so may result in inconsistent catalogs.
· Before copying a catalog, close the Catalog window and save any changes. 
{button ,AL(`administrator',0,`',`')}    See also 



 Cumulus Administration
Dividing Catalogs 

You can copy, divide or merge catalogs without affecting the original assets.
You may want to divide a catalog into two or more catalogs if any of the following conditions apply:
· The catalog has become too large. Each Cumulus catalog file can be up to 2 GB in size.
· The number of records in the catalog reduces performance significantly.
Try to divide records into logical, distinct groups. You can divide a catalog in one of two ways:
· Move small numbers of records by dragging and dropping them from one catalog to another.
· Move large portions of a catalog with Export and Import on the File menu.
{button ,AL(`administrator',0,`',`')}    See also 
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Merging Catalogs 

You can copy, divide or merge catalogs without affecting the original assets.
You can merge multiple catalogs into a single catalog by copying first the categories and then the records from one 
catalog to the other. You can use either of the following methods:
· Drag and drop files between catalogs.
· Use the Export and Import commands on the File menu.
When merging one or more catalogs remember the following:
· If the catalogs have identical category names and do not contain duplicate categories, you can drag and drop 

records from one catalog to another.
· If the catalogs share common categories but the records or hierarchies are different, move each category 

individually.
· If the catalogs have completely different categories, copy all categories to the new catalog.
{button ,AL(`administrator',0,`',`')}    See also 
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Archiving Information

Many organizations maintain several catalogs: one catalog for production assets and a second catalog to manage 
archives. With Cumulus you can also take your assets off-line and still be able to search and retrieve them. Cumulus
tracks the location of media files through file references. Whenever you move an asset, you must update the file 
reference to reflect the new location.
To archive assets:
1. Copy and/or move the assets to the new media. 
2. Merge the records into an archival catalog by first copying the categories and then the records. 
3. Copy the resulting catalog to the new media and update all file references. 
4. If desired, delete the records you archived from your production catalog.
Like other read-only media, creating an archive on CD-ROM requires that all information be set up correctly in 
advance. You can put both Macintosh and Windows files on a CD-ROM.
To create an archive on CD-ROM:
1. Create a temporary “staging” volume/drive and name it the same name as the final CD-ROM disc.
2. Copy and/or move the catalogs and assets to the staging volume/drive. 
3. Update all file references. The file references within each record must “point” to the assets located on the 

staging volume/drive.
4. Burn a new CD that contains the contents of the temporary volume/drive. Remember that the CD must have 

the same name as the staging volume/drive.
{button ,AL(`administrator',0,`',`')}    See also 



 Cumulus Network Administration
 Archiving Information

Creating Hybrid CD-ROMs
If you archive both Macintosh and Windows files to a CD-ROM, remember to use one of the following file system 
combinations:
· A hybrid CD-ROM containing an ISO 9660 file system with Joliet extension as well as a MacOS HFS file system, 

or
· An ISO 9660 CD-ROM without extensions 
Because of operating system naming restrictions, the use of other file system combinations can lead to problems 
finding files on either platform. For best results when burning CD-ROMs, Canto recommends using Adaptec¨ Toastª.
{button ,AL(`administrator',0,`',`')}    See also 
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Adding a Catalog
You can add an existing catalog to the list of catalogs available to users.
To add a catalog:
1. From the File menu, choose Connect to Server and click OK.
2. Click Add.

The Add Catalog dialog box is displayed.
3. Enter the name and full path of the existing catalog.
4. Click OK.
{button ,AL(`administrator',0,`',`')}    See also 
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Restoring a Catalog
You can restore a catalog you previously backed up.
To restore a catalog:
1. From the File menu, choose Connect to Server and click OK.
2. Click Restore.

The Restore Catalog dialog box is displayed.
3. In the Backup File Name field, enter the name and full path of the backup file.

Backup files have the extension .bak.
4. In the Destination File Name field, enter the name and full path of the catalog you will create from the backup 

file.
5. Click OK.
{button ,AL(`administrator',0,`',`')}    See also 
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Repairing a Catalog
If a catalog is damaged, you can repair it with the Repair command. Repairing a catalog can take a long time, 
depending on the size of the catalog.
To repair a catalog:
1. From the Administration menu, choose Repair.
2. If you are sure you want to recreate your catalog, click OK at the prompt.
{button ,AL(`administrator',0,`',`')}    See also 



Accelerator Keys
Accelerator keys are keyboard shortcuts to common menu commands and options. 

If you want to... Press...
Catalog assets Ctrl + B
Connect to a Cumulus Server Ctrl + Shift + O
Copy information Ctrl + C
Close a catalog Ctrl + F4
Cut information Ctrl + X
Delete information Delete
Display all records in a catalog Ctrl + G
Display the properties of a selected 
record

Alt + Return

Execute a search using the findbar Ctrl + F
Exit Cumulus Alt + F4
Launch context sensitive help F1
Move to the next dialog box tab Ctrl + Tab
Move to the previous dialog box tab Ctrl + Shift + Tab
Navigate categories or records Ctrl + arrow keys
Paste information Ctrl + V
Preview a selected asset Ctrl + Y
Print a selected item Ctrl + P
Rotate the Preview window left Ctrl + left arrow
Rotate the Preview window right Ctrl + right arrow
Switch the focus from the findbar to 
the Catalog window 

Esc

View the properties for a selected 
record

Ctrl + I

View records assigned to the selected
category 

Alt + up/down arrow

Select all categories or all records Ctrl + A
Select/deselect categories or records Ctrl + Spacebar
Select/deselect multiple records Ctrl + Spacebar or 

Shift + arrow keys
Select all records Ctrl + A
Switch between the Category and 
Record panes in the Catalog window 

Shift + Tab, 
Ctrl + Tab, or 
Ctrl + Shift + Tab

Zoom in on the Preview window Ctrl + plus sign (+) 
Zoom out on the Preview window Ctrl + minus sign (-) 
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B
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*.cce
The Cumulus Category Exchange file format, which Cumulus creates when exporting/ importing category 
information to/from other catalogs or applications.



*.ccf
The Cumulus Catalog file format, which Cumulus creates to manage cataloged digital media (or assets).



*.cqe
The Cumulus Query Exchange file format, which Cumulus creates when exporting/ importing saved query 
information to/from other catalogs or applications.



*.cre
The Cumulus Record Exchange file format, which Cumulus creates when exporting/ importing record information 
to/from other catalogs or applications.



Application Preferences dialog box
A dialog box that allows Cumulus users to customize and define general program behaviors.



Application Programming Interface (API)
A set of commands available to developers for creating applications that interact with Cumulus to provide new 
functionality.



Asset
A general term describing any type of digital media (including graphic, page layout, presentation, sound, and 
video files) used within a project. Compare with Digital media.



Boolean
A system of logic, based on two possible values: true or false. Cumulus uses the Boolean operators "and" and 
"or" to combine search conditions.



Browser
See Cumulus Browser.



Catalog
A special file ending with the extension .ccf that Cumulus creates to manage cataloged assets. See also Asset 
and Cumulus Catalog File.



Cataloging
The process by which a user adds an asset to a catalog. 



Cataloging Options dialog box
A special dialog box that controls the way in which Cumulus catalogs assets.



Catalog window
A window that features two panes (the Category pane and Record pane) that function as the central user 
interface during the cataloging process. 



Category
An organized group of records that appears in the Category pane. Categories serve as the organizational 
backbone of a Cumulus catalog.



Category Exchange File
See Cumulus Category Exchange File.



Category pane
Located on the left side of the Catalog window, the Category pane contains organized groups of records (called 
categories) that serve as the organizational backbone of a Cumulus catalog. The Category pane displays 
category and record names in a hierarchical list.



Client
A computer user who accesses a server application (such as the Cumulus Server) across a network.



Client/server architecture
A software configuration in which users (also called clients) access a server application across a network.



Compound search
A search query consisting of two or more search conditions.



Cumulus Administrator
A person who configures and manages Cumulus catalogs. The Administrator is responsible for keeping the 
catalogs running smoothly for Cumulus Client users, backing up catalogs, and other tasks. For more information, 
see the Cumulus Network 4 Administrator User Guide.



Cumulus application window
The main Cumulus window containing every program command, option, and "child" window needed to catalog, 
categorize, and manage assets.



Cumulus Browser
A royalty-free application for publishing Cumulus catalogs on CD-ROM or other removable media (e.g., Syquest, 
Zip, Jaz, or MO cartridges).



Cumulus Catalog File
A special file ending with the extension .ccf that Cumulus creates to manage cataloged digital media (or assets).



Cumulus Category Exchange File
A file ending with the extension .cce that Cumulus creates when exporting category information.



Cumulus Internet Media Server
A powerful CGI (or Common Gateway Interface) application designed to publish and distribute assets over the 
Internet.



Cumulus Network 4
An indispensable media management system for organizing and managing digital media in a client/server 
environment. See also Digital media and Client/Server Architecture.



Cumulus Network 4 Administrator User Guide
A manual describing Cumulus Administrator procedures and functions.



Cumulus Query Exchange File
A file ending with the extension .cqe that Cumulus creates when exporting saved query information.



Cumulus Record Exchange File
A file ending with the extension .cre that Cumulus creates when exporting record information.



Cumulus Server
The computer where Cumulus Server software is installed and where Cumulus catalogs should reside.



Details window
A small window (containing the record name, file type, color mode, resolution, and modification date) that 
appears when a user positions the cursor over a thumbnail. See also Record pane and Thumbnail.



Digital media
Any electronic media (including graphic, page layout, presentation, sound and video files) used within a project.



Drag and Drop
A way to move user interface objects by dragging them with the mouse and dropping them onto targets.



File filters
Software utilities that Cumulus uses to capture information about an asset during the cataloging process. For 
more information on the availability of new file filters, please see the Canto web site (www.canto.com).



File reference
The mechanism by which Cumulus tracks the actual location of an asset managed in a Cumulus catalog.



Findbar
Cumulus tool that allows users to search catalogs for records that match search conditions.



Gigabyte (GB)
A unit of storage capacity on an electronic storage device that equals 1,024 megabytes, or roughly 1.07 billion 
bytes. Cumulus catalog files can be up to 2 GB in size.



Internet Media Server
See Cumulus Internet Media Server.



Kilobyte (KB)
A unit of storage capacity on an electronic storage device that is equivalent to 1,024 bytes. 



Media file
Any electronic or digital media file (including graphic, page layout, presentation, sound and video files) used 
within a project. See also Digital media.



Megabyte (MB)
A unit of storage capacity on an electronic storage device that is equivalent to 1,024 kilobytes or 1,048,576 
bytes. 



Menubar
Appearing at the top of the Cumulus application window, the menubar lists menus that contain every program 
command.



Path/Pathname
A description of the location where a file is stored on a computer hard drive, server, or removable media (such as
CD-ROM, Syquest, Zip, Jaz, or MO cartridges).



Popup menu
A shortcut menu that appears when you move the cursor over an object and click the right mouse button. 



Preview
A special program mode in which you can examine cataloged assets including video clips, sound files, and image
files.



Querybar
Stores saved search queries for future use.



Query Exchange File
See Cumulus Query Exchange File.



Record
The actual catalog entry Cumulus creates when an asset is added to a catalog. Records store valuable 
information about an asset such as the file name, file location, file type, resolution, etc. 



Record Exchange File
The Cumulus Record Exchange file format, which Cumulus creates when exporting/ importing record information 
to/from other catalogs or applications.



Record pane
Located on the right side of the Catalog window, the Record pane displays records as thumbnails or plain text. 
See also Record and Thumbnail.



Record Properties dialog box
A special window that stores valuable record information about a cataloged asset. See also Record.



Resolution
The number of pixels per inch in any graphic file format. Higher-resolution files have a higher number of pixels 
per inch than lower-resolution files. Working with higher-resolution files usually requires more memory and hard 
disk space than working with lower-resolution files.



Script
A list of instructions executed by a computer. Scripts are used by Cumulus to perform complex tasks 
automatically.



Simple search
A search query consisting of one search condition.



Status
A condition assigned by a user to describe the state of a particular asset.



Status bar
A bar at the bottom of the Cumulus Application window that provides tool button descriptions, access to the 
Application Preferences dialog box, and category/record status.



Thumbnail
A miniature display of a cataloged asset that appears in the Record pane and Record Properties dialog box.



Toolbar
A standard program tool that offers buttons as shortcuts to commonly used commands.



Tooltip
A small floating descriptive window that appears above a toolbar button when the cursor is positioned over it.




